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Apresentação 

O uso racional dos recursos naturais e, em particular, a conservação das florestas amazônicas 
estão no centro das discussões das medidas mitigadoras necessárias para minimizar os 
efeitos das mudanças climáticas. Nesse contexto, é fundamental o desenvolvimento de 
políticas públicas para o uso sustentável dos ecossistemas florestais da Amazônia. A 
implementação dessas políticas passa necessariamente pelo maior conhecimento de técnicas 
de uso e manejo, associadas ao monitoramento efetivo das florestas tropicais, viabilizando a 
manutenção desses ecossistemas. 

Apesar de todos os esforços das diferentes esferas governamentais no Brasil, alcançando na 
última década reduções substanciais nas taxas anuais de desmatamento, as perdas de 
florestas por causas naturais e antrópicas ainda são bastante elevadas. Parte da solução vem 
pela viabilização de técnicas de manejo florestal que por um lado barateiem os custos de 
elaboração e execução dos planos de manejo florestal (PMF), aumentando a competitividade 
dessa atividade. Por outro lado, também é necessário o desenvolvimento de tecnologias que 
facilitem o monitoramento desses PMF não apenas pela redução de custos, mas também 
pelo aumento da eficiência das ferramentas disponíveis aos técnicos da administração 
pública, em particular dos órgãos de fiscalização e controle.

A equipe da Embrapa Acre vem contribuindo, ao longo das últimas duas décadas, para o 
desenvolvimento de técnicas de manejo florestal adequadas a pequenos e grandes produtores, 
promovendo a diminuição de custos e aumento dos rendimentos das operações florestais.

Nos últimos anos, especialmente pelo uso de geotecnologias, foi possível desenvolver o 
Modeflora, um conjunto de ferramentas e de técnicas que constituem uma metodologia 
inovadora de manejo digital de precisão que tem sido adotada por empresários do setor 
florestal e órgãos governamentais estaduais e federais na gestão de PMF.

Com este livro damos mais um passo à frente no manejo de precisão pela incorporação do 
perfilamento a laser (Lidar – light detection and range) como ferramenta de planejamento e 
monitoramento de florestas tropicais. 

Ao longo do livro é descrita em detalhe a metodologia de elaboração de modelos 
tridimensionais do terreno de elevada precisão que permitem ao usuário planejar todas as 
operações relativas ao manejo florestal, monitorar os impactos dessas operações e a 
estimativa de biomassa, volume e estoques de carbono das florestas amostradas pelo Lidar. 

Os modelos apresentados no livro foram construídos e validados em um plano de manejo 
florestal administrado pelo governo do Estado do Acre, na Floresta Estadual do Antimary, por 
meio de uma parceria entre Embrapa, Serviço Florestal Americano e governo do Estado do 
Acre. 

O formato de apresentação do livro em passo a passo permite que mesmo usuários sem 
conhecimento profundo dos softwares envolvidos na construção dos modelos sejam capazes 
de desenvolvê-los. Da mesma forma, a disponibilização de amostras de dados brutos Lidar, 
linhas de comando e de todos os modelos produzidos permite que o livro seja utilizado em 
cursos de graduação ou pós-graduação contribuindo na formação profissional desses alunos.

Eufran Ferreira do Amaral
Chefe-Geral da Embrapa Acre





Prefácio

O planejamento da estrutura de apoio (rede de estradas, pontes e pátios de estocagem) e das 
operações florestais em planos de manejo em florestas tropicais é bastante limitado pela 
falta de informações precisas sobre a topografia e rede de drenagem das áreas manejadas. 
Da mesma forma, o monitoramento da perda de biomassa e dos impactos produzidos pela 
atividade florestal é caro e difícil de obter somente por meio de sensores remotos tradicionais 
(ex. imagens de satélite).

O Lidar é uma ferramenta que possui uma grande variedade de aplicações, sendo capaz de 
desenvolver modelos tridimensionais do terreno de alta resolução. Os produtos aqui descritos 
podem ser adaptados para estudos em diversas áreas do conhecimento (ex. de estudos 
ecológicos à mineração). No entanto, da forma como foi elaborado, este livro é direcionado 
principalmente a profissionais do setor florestal que atuam na área de gestão de meio 
ambiente, elaboração, análise e acompanhamento de planos de manejo florestal. Nosso 
objetivo é oferecer a esses profissionais uma descrição de como processar e gerar modelos 
digitais do terreno a partir de dados brutos de Lidar aerotransportado. 

As metodologias para a obtenção dos produtos são descritas no formato passo a passo com 
a utilização de programas de acesso livre e comerciais. O processamento primário dos dados 
brutos do Lidar é feito com o programa Fusion produzido pelo Serviço Florestal Americano 
(software livre) e os modelos digitais do terreno produzidos manipulados no programa 
ArcGis. 

Nos dois primeiros capítulos apresentamos uma breve introdução aos fundamentos do Lidar 
e suas aplicações florestais e uma descrição dos programas acessórios usados no 
processamento dos dados brutos Lidar. Não foi nosso objetivo “ensinar” aos leitores como 
utilizar todos os recursos desses programas, mas apenas informá-los dos comandos 
essenciais necessários para a geração dos produtos que fazem parte do livro.

Nos capítulos seguintes apresentamos de forma detalhada a construção de modelos digitais 
do terreno úteis para o planejamento e monitoramento de planos de manejo florestal e a 
estimativa de parâmetros estruturais da floresta (área basal, volume e biomassa). Os modelos 
apresentados seguem a legislação florestal brasileira e são construídos por meio de 
adaptações de modelos já publicados.

Os dados Lidar que acompanham o livro são amostras de dois levantamentos feitos em uma 
área de concessão florestal na Floresta Estadual do Antimary, no Estado do Acre, nos anos de 
2010 e 2011, com recursos do programa internacional do Serviço Florestal Americano. 
Acompanham os dados Lidar as linhas de comando utilizadas e os modelos produzidos em 
cada capítulo. Isso permite ao usuário manipular dados Lidar e comparar os resultados 
obtidos com os fornecidos. Dessa forma, este livro também poderá ser utilizado em 
universidades como parte do conteúdo de disciplinas regulares ou cursos de extensão.

Esperamos com isso contribuir na formação de profissionais e alunos de cursos afins. 
Acreditamos que o uso do Lidar, como ferramenta no manejo de florestas tropicais, será cada 
vez mais comum no futuro e que o aprendizado das técnicas aqui contidas irá contribuir para 
o aperfeiçoamento da elaboração, análise, execução e monitoramento de planos de manejo, 
por consequência promovendo o uso racional e sustentável das nossas florestas.

Os autores
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1. Fundamentos do Lidar e suas aplicações em florestas tropicais

1.1. Breve histórico do Lidar

Embora Schawlow e Townes (1958) sejam genericamente reconhecidos como os inventores 
do laser a partir da publicação Infrared and Optical Masers (microwave amplification by 
stimulated emission of radiation) na Physical Review, apenas um ano mais tarde o termo 
laser seria usado pela primeira vez por Gordon Gould em 1959 (Gould, 1959). Schawlow e 
Townes receberam a primeira patente para o laser em 1961 (o que gerou uma disputa com G. 
Gould que durou até meados dos anos 1980). Lidar apareceu logo em seguida (RING, 1963), 
combinando radar e laser (que aparentemente é a verdadeira origem da palavra light + radar 
= lidar). Somente na década de 1970, Lidar começou a ser interpretado como uma abreviação 
(que também derivava do Radio Detection and Range – Radar) que podia ser interpretado 
como Laser Imaging Detection and Ranging. Três décadas depois, a terminologia Ligth 
Detection and Ranging (Lidar) é amplamente conhecida, principalmente no campo do 
conhecimento de sensoriamento remoto (Centeno; Mitishita, 2007), enquanto Laser 
Detection and Ranging (Ladar) tinha a preferência dos militares.

Nas missões à Lua da Apollo 15, 16 e 17, realizadas na década de 1970, o laser altimétrico foi 
usado como instrumento de bordo importante para o sucesso das operações espaciais e 
mapeamento do solo lunar (Kaula et al., 1974). Na década de 1980, os militares norte-
americanos intensificaram o uso da tecnologia laser para mensuração de distâncias, por meio 
do instrumento Airborne Topographeric Mapper (ATM) que ainda hoje compõe muitos 
instrumentos de varredura Lidar aerotransportado (Carabajal et al., 1999). 

A princípio os feixes de luz emitidos pelo sistema Lidar não tinham como ser referenciados, 
ou melhor, georreferenciados de forma precisa. O Sistema de Posicionamento Global (GPS) 
poderia ser uma solução para referenciar a nuvem de pontos. Porém, os códigos utilizados 
pelo GPS para o uso civil apresentavam disponibilidade seletiva (Selective Availability – SA). 
A disponibilidade seletiva, imposta pelo Departamento de Defesa Norte-Americano, conferia 
ao sinal da constelação GPS uma deterioração da acurácia de forma aleatória, resultando em 
uma acurácia horizontal e vertical de 100 m e 140 m (Monico, 2008) que praticamente 
inviabilizava o uso de muitas tecnologias de sensoriamento remoto.

Associado ao erro produzido pela disponibilidade seletiva, a constelação GPS possuía uma 
taxa de atualização de apenas um sinal por segundo. Essa restrição tornava impraticável o 
pós-processamento da nuvem de pontos Lidar dos retornos emitidos pelo scanner laser em 
uma frequência de milhares de pulsos por segundo. Assim, na década de 1980, para o uso 
civil e científico, não era possível trabalhar com precisão o sensoriamento com dados Lidar.

A partir da década de 1990, com o aperfeiçoamento dos sensores laser, como o Mars Observer 
Laser Altimeter (MOLA) e o Shuttle Laser Altimeter (SLA) (Abshire et al., 2000; Carabajal 
et al., 1999), e a abolição da degradação da acurácia pela disponibilidade seletiva a partir de 
2 de maio de 2000 (Monico, 2008), o emprego da tecnologia Lidar tornou-se viável.

Em 2006, a empresa californiana SiRF Technology Inc., sediada em San Diego, disponibilizou 
no mercado o chipsets Sirf Star e seu software para receptores GPS. Esse chipsets tinha a 
promessa de revolucionar o uso do GPS em decorrência da alta capacidade de decodificar 
sinais em níveis extremamente baixos (- 160 dBm). A alta sensibilidade do Sirf Star possibilitou 
ampliar o uso dos receptores GPS de maneira rápida e segura, principalmente, em ambientes 
florestais (Garmin, 2007; Sirf, 2014). Atualmente, os sensores de alta sensibilidade equipam 
os receptores do Sistema Global de Navegação por Satélites (GNSS) pós-processados L1/L2.

A evolução das técnicas de georreferenciamento, conjuntamente com o aperfeiçoamento dos 
Lasers Scanners, permitiu que o processamento da nuvem de pontos do Lidar alcançasse 
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precisão submétrica, possibilitando seu uso na engenharia civil, geologia, agronomia, 
topografia, engenharia florestal e em muitas outras áreas do conhecimento.

1.2.	 Funcionamento do sistema Lidar

O Lidar é um sensor remoto ativo, que permite a coleta de dados pela emissão de sua própria 
luz e independe da presença de uma fonte de luz externa, como é o caso dos sensores passivos 
(fotografias aéreas e imagens de satélite). O princípio do funcionamento do Lidar consiste na 
emissão de um pulso de laser na direção de uma superfície ou objeto. Ao atingir o alvo, a luz 
é refletida na direção contrária e retorna ao sistema laser. Seguindo os princípios de 
triangulação ou da medição do tempo de retorno do pulso refletido (Time-of-Flight), o sistema 
Lidar calcula a distância entre o sensor e o objeto (Andersen et al., 2003; Wagner et al., 
2004).

O sistema Lidar pode realizar uma varredura a partir de uma plataforma terrestre fixa ou 
móvel (veículo automotor), aeronave ou um sistema orbital (satélite ou estação espacial) 
(NASA, 2014; Wagner et al., 2004). 

Para o laser aerotransportado ou Airborne Laser Scanner (ALS), o conjunto do sistema laser 
é mais complexo, em decorrência da movimentação da aeronave, em três eixos distintos 
provocados pela turbulência atmosférica (Behan, 2000; Lima et al., 2002). O conjunto é 
constituído por um Sistema Inercial de Navegação (INS) e um par de receptores GNSS L1/L2 
(Figura 1), sendo um instalado no sistema laser na aeronave e outro no solo (Giongo et al., 
2010).

Figura 1. Esquema operacional do sistema Lidar aerotransportado. 
Fonte: Giongo et al. (2010).

O receptor GNSS no solo (estação de referência) deve, preferencialmente, ser instalado numa 
base homologada de georreferenciamento, de maneira que possa estabelecer um vetor de 
até 50 km e quando possível menor que 20 km da área sobrevoada para o perfilamento 
(Monico, 2008; Ramos et al., 2007). 

O pós-processamento da nuvem de pontos tem a finalidade de proceder à interpolação de 
coordenadas geográficas corrigidas pelos dados coletados pelo receptor GNSS de solo 
(estação de referência) e pela rede de monitoramento do sistema GNSS (estações de referência 
governamentais), atribuindo uma coordenada X,Y,Z a cada ponto pulsado pelo sistema laser. 

De acordo com a potência do Lidar, um único pulso de laser pode produzir múltiplas reflexões 
gerando vários retornos úteis dos alvos atingidos na superfície. Assim, um pulso pode ser 
fracionado em diversos outros pontos refletidos em alvos diferentes na mesma linha do 
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pulso laser. O ponto mais próximo do sistema Lidar originará o primeiro retorno do pulso 
laser, enquanto o ponto mais distante vai gerar o último retorno. Esse processo de leitura da 
informação é importante quando se considera a diferença de penetração que pode existir a    
partir de um único pulso (Behan, 2000), o que permite a distinção de elevações.

1.3. Principais empregos do Lidar na engenharia florestal

A aquisição das informações descrevendo vegetação, bacias hidrográficas e topografia, 
necessárias para a elaboração, execução e monitoramento de planos de manejo em campo, 
é cara e de difícil obtenção nas florestas tropicais. Isso se verifica especialmente na Amazônia 
Brasileira, devido à dificuldade de acesso, grandes áreas a serem amostradas e limitações à 
execução de trabalhos de campo durante a estação das chuvas. Além disso, mesmo com o 
uso de equipamentos, como o GPS para localização de árvores e microzoneamento 
(Figueiredo et al., 2007), a interferência das árvores na recepção dos sinais de satélite 
produz caminhos múltiplos que reduzem de forma significativa a precisão da posição dos 
pontos tomados em campo.

Para reduzir a necessidade de trabalhos de campo e aumentar a precisão das estimativas e 
modelos produzidos a partir dos dados coletados, estudos sobre o uso de ferramentas de 
sensoriamento remoto aplicado à área florestal foram intensificados a partir da década de 
1990 (Zandoná et al., 2008).

Desde o final da década de 1990, o uso florestal do Lidar foi voltado para a estimativa de 
parâmetros estruturais das florestas. Modelos de superfície eram construídos para a 
caracterização precisa da topografia do terreno e as informações usadas no planejamento de 
estradas, pontes e outras estruturas de apoio às operações florestais. Os dados do Lidar 
geram informações sobre a superfície do dossel e parâmetros como altura das árvores e 
dimensões das copas, elementos importantes para o manejo, tanto de florestas nativas como 
de plantadas (Popescu et al., 2002; Tiede et al., 2005).

Os sistemas de Lidar aerotransportado permitem a cobertura em larga escala da superfície, 
produzindo dados que podem ser usados para a elaboração de modelos digitais do terreno 
de alta resolução de grandes áreas de floresta (Reutebuch et al., 2003; Zonete, 2009). Com 
o uso do Lidar aerotransportado, tanto a resolução horizontal como a vertical no terreno 
podem chegar a níveis submétricos, proporcionando a precisão necessária tanto para o 
planejamento do uso, como para o monitoramento de florestas. 

Os estudos por amostragem de área seguem o princípio de estimar o número de árvores, 
volume, altura e biomassa a partir de um inventário florestal amostral da área de interesse a 
ser perfilada pelo scanner a laser. Com as unidades amostrais georreferenciadas, identificadas, 
inventariadas e perfiladas é obtido um conjunto de variáveis explicativas com dados da 
floresta amostrada e dados do processamento da nuvem de pontos, que permitirá a construção 
de equações de regressão para estimar os parâmetros estruturais da floresta (volume e 
biomassa) em grandes extensões de florestas amostradas pelo Lidar aerotransportado.

Estudos com Lidar têm sido realizados na aquisição de dados geográficos com aplicação em 
várias áreas. Levantamentos aerotransportados com Lidar têm sido largamente utilizados 
para estimativa de biomassa em florestas temperadas (ANDERSEN et al., 2006; BEETS et al., 
2011; LEFSKY et al., 2002; MAGNUSSEN et al., 2010; NÆSSET, 1997, 2004; NELSON et al., 
1988). Esses estudos demonstraram uma forte correlação entre dados obtidos pelo Lidar, 
biomassa e estrutura da floresta.

A utilização do Lidar em florestas tropicais é bem mais recente e especialmente voltada para 
estudos ecológicos e de avaliação de estoques de carbono (e.g. ASNER et al., 2008, 2010; 
DRAKE et al., 2002, 2003; KENNAWAY et al., 2008).



22

Uso do Lidar como Ferramenta para o Manejo de Precisão em Florestas Tropicais

Além do uso do Lidar em trabalhos de mensuração florestal de larga escala, também é 
possível usar essa tecnologia para o estudo de árvores individuais. Roberts et al. (2005) e loki 
et al. (2010) já haviam alcançado resultados similares para equações de estimativas biométricas 
(DAP, Ht, diâmetro de copa e volume), porém, em plantações de pínus. A concepção de 
entender a floresta a partir das copas ainda é um conceito inovador na academia de engenharia 
florestal, devido às dificuldades de coleta em campo das informações de copa. As informações 
geradas pelo Lidar aerotransportado abrem uma nova perspectiva de compreensão dos 
ecossistemas florestais com o aprofundamento dos estudos das variáveis oriundas do 
processamento da nuvem de pontos, bem como das variáveis morfométricas de copa. Os 
resultados de pesquisa com a morfometria da copa de árvores individuais pelo perfilamento 
com Lidar aerotransportado ainda são escassos e os estudos biométricos, na sua maioria, 
foram desenvolvidos em florestas no hemisfério norte (ANDERSEN et al., 2011; BOTTAI et al., 
2013; HOLMGREN et al., 2003).

Figueiredo (2014) desenvolveu equações para estimar o volume e a biomassa do fuste de 
árvores individuais utilizando dados morfométricos de copa (diâmetro de copa, área de 
projeção de copa, volume de copa, comprimento de copa e manto de copa), obtidos pelo 
Lidar aerotransportado na Floresta Estadual do Antimary – FEA (Figura 2). 

As árvores com copas danificadas ou quebradas podem ser identificadas pelo processamento 
do Lidar e apontadas como outliers pela análise de influência durante o processo de 
modelagem biométrica. Essas árvores com copas danificadas ganham importância no 
planejamento florestal e na estratégia de manejo das florestas tropicais, funcionando como 
o primeiro tratamento silvicultural com retorno econômico (Figura 3).

A B C

Figura 2. Árvores individuais isoladas da vegetação de sub-bosque com dados do Lidar: A) 
Dipteryx odorata Wild (cumaru-ferro), B) Ceiba pentandra (L.) Gaertn. (samaúma), C) Apuleia 
leiocarpa (Vogel) J.F. Macbr. (cumaru-cetim), Floresta Estadual do Antimary, Acre, Brasil.
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Figura 3. Nuvens de pontos do Lidar de uma árvore com a copa quebrada da espécie Dipteryx 
odorata Wild (cumaru-ferro), Floresta Estadual do Antimary, Acre, Brasil.
 
Muitos outros trabalhos têm demonstrado a importância do Lidar como instrumento de 
mensuração e planejamento florestal (Tabela 1). Novas estratégias de manejo de precisão em 
florestas tropicais podem ser desenvolvidas a partir da combinação do emprego do Lidar 
com o Modelo de Exploração Florestal (ANDERSEN et al., 2014; d’OLIVEIRA et al., 2012; 
FIGUEIREDO et al., 2007, 2014). Esta publicação tem por objetivo mostrar, passo a passo, os 
procedimentos de criação de modelos digitais do terreno necessários ao planejamento e 
monitoramento de operações florestais e modelos de regressão para estimativas de estoque 
de biomassa a partir de dados Lidar. O passo a passo está numerado de forma contínua e 
segue a sequência dos capítulos desta publicação.

A área apresentada como exemplo neste trabalho faz parte da Floresta Estadual do Antimary 
(FEA), localizada nos municípios de Rio Branco e Sena Madureira, Acre (68o 01’ a 68o 23’ W; 9o 
13’ a 9o 31’ S), com área de 76.832 hectares (FUNTAC, 1990). Os dados Lidar na FEA foram 
obtidos por meio da cooperação da Embrapa Labex manejo florestal e o programa internacional 
do Serviço Florestal Americano (USDA Forest Service International Program). Foram realizados 
dois sobrevoos nos anos de 2010 e 2011, cobrindo uma área de floresta manejada de 1.000 
hectares a 500 m de altura. Foi utilizado um avião SENECA II – EMBRAER 810C equipado com 
um sistema de Lidar Optech ALTM3100EA. A densidade média de pontos foi de 25 m-² e 
frequência de emissão de pulsos de 70 hz com 4 retornos úteis por pulso. 

Neste livro usou-se parte das amostras Lidar da FEA cujos resultados foram publicados por 
d´Oliveira et al. (2012) e Andersen et al. (2014). Nestes estudos os autores desenvolveram 
modelos digitais do terreno para o monitoramento dos impactos da exploração florestal na 
floresta e adotaram procedimento de amostragem por área para estimar a biomassa florestal, 
por meio da construção de modelos de regressão entre as variáveis explicativas derivadas do 
processamento da nuvem de pontos do Lidar e amostras de um inventário florestal de 
referência.
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Para facilitar o entendimento e aprendizado, acompanham a publicação, além das amostras 
de dados Lidar, arquivos com as linhas de comando e modelos digitais do terreno que são 
usados como exemplo para geração dos produtos que compõem este livro. Para o 
funcionamento correto das linhas de comando, o material do CD deve ser integralmente 
copiado para o drive C do computador que será usado pelo usuário, preservando a mesma 
nomenclatura e estrutura dos diretórios originais.
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Tabela 1. Exemplos de uso do Lidar em distintas aplicações na engenharia florestal.

Variáveis florestais Forma de obtenção dos 
dados pelo Lidar

Exemplo de uso na literatura acadêmica

Altura de árvores individuais Medida direta Chen et al. (2006); Figueiredo (2014); Lingnau 
et al. (2008); Næsset; Okrand (2002); Roberts 
et al. (2005)

Altura do dossel Medida direta Andersen et al. (2003); Coops (2007); 
Holmgren et al. (2003); Popescu et al. (2002); 
Zimble et al. (2003)

Área basal Modelagem biométrica Andersen et al. (2003); Gobakken; Hudak et 
al. (2006); Næsset (2004)

Área de projeção de copa Medida direta Figueiredo (2014)

Área de preservação permanente
Área de acesso restrito
Hidrografia

Modelagem d’Oliveira; Papa (2013)

Biomassa Modelagem biométrica Andersen et al. (2005, 2011, 2014); Danilin; 
Medvedev (2004); d’Oliveira et al. (2012);  
Lim et al. (2004); Næsset; Gobakken (2008)

Biomassa de árvores individuais Modelagem biométrica Figueiredo (2014); Popescu et al. (2002)

Diâmetro à altura do peito (DAP) Modelagem biométrica Gobakken; Næsset (2004); Lingnau et al. 
(2008)

Diâmetro de copa Medida direta Figueiredo (2014); Næsset; Okrand (2002); 
Popescu et al. (2003); Roberts et al. (2005)

Impacto de exploração Modelagem d’Oliveira et al. (2012); Figueiredo (2014)

Manto de copa Medida direta Figueiredo (2014); Roberts et al. (2005); 
Sasaki et al. (2008).

Número de indivíduos Medida direta Bottai et al. (2013); Chen et al. (2006); 
Gonçalves et al. (2011); Næsset (2004);  
Tiede et al. (2005); Zonete (2009)

Volume de copa Medida direta Coops (2007); Figueiredo (2014)

Volume do fuste de árvores 
individuais

Modelagem biométrica Bottai et al. (2013); Figueiredo (2014); 
Popescu et al. (2003)

Volume Modelagem biométrica Andersen et al. (2003); Holmgren et al. 
(2003); loki et al. (2010)

Fonte: adaptado de Giongo et al. (2010).
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2. Programas acessórios para o processamento dos dados brutos Lidar

Os programas utilizados para a manipulação inicial e processamento dos dados brutos do 
Lidar serão apresentados neste tópico. São eles: MS-DOS, Bloco de notas, Fusion e Lidar 
Data Viewer (LDV). As instruções de uso dos programas serão apresentadas de forma sucinta. 
Esta seção tem como finalidade introduzir as funções essenciais desses programas, as quais 
serão utilizadas para elaborar modelos que fazem parte deste trabalho, contidas no CD Livro_
Lidar.

2.1. MS-DOS

O processamento dos dados brutos do Lidar será feito por meio do programa Fusion no 
ambiente Disk Operating System ou Sistema Operacional em Disco (MS-DOS). Lançado na 
década de 1980, o MS-DOS é um sistema operacional antigo, entretanto muitas de suas 
funções são aplicadas ainda hoje. Os produtos do Fusion serão obtidos por meio da execução 
de linhas de comando no ambiente DOS. Como essas linhas de comando podem ser longas 
e serão utilizadas diversas vezes, é possível salvá-las em arquivos tipo Batch (.BAT) para 
facilitar a manipulação dos dados e evitar erros de sintaxe. Os comandos são executados 
após pressionar a tecla Enter. Um processamento iniciado no MS-DOS não deve ser 
interrompido por outra requisição até ter sido finalizado. Segue abaixo a execução de uma 
linha de comando (BAT) no MS-DOS:

1.	 Abrir o programa MS-DOS (Prompt de comando).

2.	Entrar no diretório C:\Fusion.

3.	Digitar ou copiar a linha de comando (nome do arquivo BAT) com o caminho de acesso 
(Ex. C:\Livro_Lidar|BAT\Modelo_Superfície_Dossel_Exemplo.bat) no MS-DOS (Figura 4).

4.	Pressionar Enter.

Figura 4. Janela de visualização do MS-DOS; comandos de saída e entrada em pastas de 
trabalho; exemplo de linha de comando responsável pela criação do modelo de superfície de 
dossel; execução de linha de comando (Bat file) no MS-DOS.
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2.2. Bloco de notas

2.2.1. Criação, edição e registro de arquivos .BAT de linhas de comando do Fusion

O Bloco de notas será usado para editar e salvar as linhas de comando que serão utilizadas 
no programa Fusion com a extensão .BAT. Essas linhas de comando serão usadas para 
produzir todos os modelos no Fusion a partir de dados Lidar.

Os arquivos com extensão “BAT” ou arquivos de lote normalmente possuem uma sequência 
de comandos que são executados em bloco. No CD Livro_Lidar, os arquivos “BAT” estão 
localizados dentro da pasta BAT. O nome do arquivo “BAT” faz referência ao tipo de operação 
realizada com os dados Lidar. As linhas de comando devem ser executadas no MS-DOS, 
sempre no diretório C:\Fusion.

As linhas de comando podem ser visualizadas no Bloco de notas por meio do comando 
“editar”. Para selecionar um arquivo para edição, clicar sobre o nome do arquivo com o botão 
direito do mouse. Ao selecionar o comando editar, a linha de comando será aberta no Bloco 
de notas e poderá ser modificada. É importante observar que quando a opção “abrir” é 
selecionada em arquivo tipo batch, a respectiva linha de comando é executada automaticamente.

2.2.2. Criação de arquivos de texto de referência para dados Lidar a serem utilizados no 
processamento de modelos digitais do terreno no Fusion

O Bloco de notas também é usado para criar arquivos texto (.TXT) contendo o endereço e 
nome dos arquivos de dados Lidar (.LAS) que serão usados para compor os modelos a ser 
processados. Esse procedimento é utilizado para facilitar a execução de comandos do Fusion 
que envolvam o processamento de várias amostras Lidar de uma só vez. Dessa forma, inclui-
se na linha de comando para criação de um modelo apenas o arquivo de texto (.TXT) com a 
referência do conjunto de dados Lidar a ser utilizado.

A criação do arquivo de referência para as amostras Lidar segue o procedimento:

5.	Abrir o programa Bloco de notas.

6.	Digitar o endereço da localização dos arquivos de dados Lidar utilizados. Cada arquivo 
deve ocupar uma linha como no exemplo abaixo:

C:\Livro_Lidar\LAS_LDA\Exemplo_01.las

C:\Livro_Lidar\LAS_LDA\Exemplo_02.las

C:\Livro_Lidar\LAS_LDA\Exemplo_03.las

C:\Livro_Lidar\LAS_LDA\Exemplo_04.las

7.	 Nomear e salvar o arquivo: ex. C:\Livro_Lidar\TXT\Amostra_Exemplo.txt (Figura 5).
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Figura 5. Exemplo de arquivo texto do Notepad, com nome e pasta (endereço do diretório) 
onde estão armazenados os arquivos de dados Lidar que serão usados pelas linhas de 
comando na elaboração dos modelos.

2.3. Uso de Software Livre Fusion/Lidar Data Viewer (LDV)

Fusion é um programa livre, desenvolvido pelo Serviço Florestal Americano (MCGaughey, 
2010), usado para criar imagens de alta resolução e modelos digitais do terreno em 3D. Esse 
software foi desenvolvido originalmente para ajudar pesquisadores a compreender, explorar 
e analisar dados Lidar (MCGaughey, 2010). Suas ferramentas permitem análises básicas e 
avançadas de um grande volume de dados Lidar, obtendo produtos que podem ser exportados 
para softwares usuais de sistema de informação geográfica (SIG). Esses programas têm 
múltiplas funções e aplicações, mas nesse segmento serão apresentadas apenas as operações 
essenciais para a elaboração e exportação de modelos digitais do terreno a partir de dados 
brutos do Lidar.

2.3.1. Geração de imagens de referência a partir de amostras de dados obtidos com sistema 
Lidar (arquivos .LAS ou .LDA)

8.	 Executar o programa Fusion, clicar em “tools>Miscellaneous utilities> Create an image 
using Lidar point data” (Figura 6).

9.	 Abrir o diretório (ex. C:\Livro_Lidar\LAS_LDA).

10.	Selecionar os arquivos de interesse (Exemplo_01.lda, Exemplo_02.lda, Exemplo_03.lda e 
Exemplo_04.lda) e pressionar Ok.

11.	Será aberta, automaticamente, a janela chamada “Image Creator”.

12.	Selecionar no campo “Image options” a opção “Color based on elevation”.

13.	Clicar na opção “Scan for data ranges”. Essa opção irá gerar um histograma de distribuição 
dos dados (retorno) por classe de elevação.

14.	Anotar os valores de elevação mínima e máxima na janela “Data limits”, que apresenta o 
histograma de distribuição do número de retornos por classes de elevação (Figura 7).

15.	Selecionar, na tela Image Creator a opção Clamp data range e preencher os valores 
anotados de elevação mínima e máxima nos campos Min value e Max value, 
respectivamente. Esse procedimento limita a classificação das cores na escala cinza aos 
valores observados na amostra melhorando a qualidade da imagem produzida.

16.	Digitar o valor 1 no campo Pixel size. Esse valor é o tamanho do elemento fotográfico  
(1 m x 1 m) da imagem que será gerada e pode variar de acordo com a densidade de 
pontos da amostra ou o interesse do usuário.
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17.	Digitar no browse superior o endereço onde a imagem será salva (ex. C:\Livro_Lidar\
Imagem\Amostra_FEA_Exemplo.bmp).

18.	Clicar em Create image para que o arquivo seja gerado conforme as configurações 
definidas. 

19.	Clicar em close assim que a imagem tiver sido criada. A palavra done! irá aparecer acima 
do botão close. 

20.	 Clicar em imagem e selecionar o arquivo de imagem gerado (ex. C:\Livro_Lidar\Imagem\     	
	Amostra_FEA_Exemplo.bmp) (Figura 8).

 

Figura 6. Janela do Fusion para criação de imagem com dados Lidar.
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Figura 7. Histograma com a distribuição do número de retornos por classe de elevação. 
 

Figura 8. Imagem (Amostra_FEA_Exemplo.bmp) gerada a partir das amostras de dados brutos 
Lidar aberta no programa Fusion. 
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2.3.2. Adição de dados brutos (arquivos .LAS e .LDA) no Fusion 

Esse procedimento tem por objetivo carregar os dados Lidar referentes à imagem gerada na 
etapa anterior (Amostra_FEA_Exemplo.bmp): 

21.	Clicar em Raw_data (barra de ferramentas lateral do Fusion) e selecionar todos os arquivos 
.LAS localizados na pasta onde estão os dados brutos do Lidar (ex. C:\Livro_Lidar\LAS_
LDA\Exemplo_01.las, Exemplo_02.las, Exemplo_03.las e Exemplo_04.las) (Figura 9).

22.	Clicar Ok na janela Data files (Figura 10).

23.	Assinalar a caixa Raw data para visualizar a grade de dados sobre a imagem gerada na 
etapa anterior (Figura 11).

Figura 9. Janela para seleção de amostras de dados Lidar a serem carregados pelo programa 
Fusion. 

Figura 10. Janela Data files com as amostras dos dados brutos Lidar selecionadas.
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Figura 11. Grade das amostras de dados Lidar sobrepostos à imagem Amostra_FEA_Exemplo.
bmp no programa Fusion. 

2.3.3. Visualização de amostra de dados Lidar em três dimensões 

O Lidar Data Viewer (LDV) permite a visualização e edição dos dados Lidar em formato 
tridimensional. Para que o LDV possa ser utilizado é preciso que a imagem (Amostra_FEA_
Exemplo.bmp) e a grade de dados Lidar (Exemplo_01, Exemplo_02, Exemplo_03 e Exemplo_04) 
estejam carregadas no Fusion.

24.	Pressionar e arrastar o botão esquerdo do mouse sobre a imagem Amostra.bmp e 
selecionar uma área de interesse (polígono) a ser visualizada em 3D. Usando a função 
Sample options é possível definir forma e dimensões da amostra (Sample shape), coloração 
por intensidade, elevação ou número do retorno (color e color classification) e filtrar a 
nuvem de pontos para retornos da superfície e dossel quando estes modelos estiverem 
disponíveis (Bare Earth Filter e Canopy Surface Filter). Para que a amostra selecionada 
para visualização possa ser vista na imagem de referência, a caixa “Display Sample” deve 
estar marcada (Figura 12).

25.	O programa Lidar Data Viewer será executado e os dados localizados dentro do polígono 
selecionado serão visualizados em 3D (Figura 13). A mensagem no data within specified 
area surge quando uma área da imagem que não contém dados Lidar é selecionada.
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Figura 12. Seleção de amostra de dados Lidar para visualização no Lidar Data Viewer.

Figura 13. Amostra de dados Lidar aberta no Lidar Data Viewer. 
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2.4. Exportação de modelos digitais do terreno (DTM) para ArcGis

Modelos digitais do terreno são elaborados a partir de dados brutos do Lidar. Os modelos 
gerados no programa Fusion são exportados para o ArcGis, onde serão obtidos novos dados 
relacionados à hidrografia, topografia, biomassa e impacto sobre a floresta, auxiliando assim 
a elaboração e execução de planos de manejo florestal, como será descrito ao longo dos 
próximos capítulos. Os procedimentos para essa conversão serão apresentados abaixo e 
repetidos para todos os modelos a serem gerados no Fusion e que precisem ser exportados 
para outros softwares.

2.4.1. Conversão de arquivos DTM para o formato ASCII

Os modelos digitais do terreno criados pelo Fusion podem ser abertos e editados em outros 
programas de geoprocessamento. Para que isso seja possível, o modelo deve ser convertido 
da forma .DTM para o formato ASCII. Os arquivos American Standard Code for Information 
Interchange (ASCII – Padrão Americano de Código para o Intercâmbio de Informação) são 
códigos numéricos usados para representar caracteres que podem ser lidos por quase todos 
os computadores e programas de texto.

26.	Executar o Fusion, clicar em opção tools > terrain model > export model no menu principal.

27.	Clicar no primeiro campo browse e buscar o arquivo DTM que será convertido (ex. C:\
Livro_Lidar\DTM\Modelo_Superficie_Exemplo.dtm).

28.	Clicar no segundo campo browse e selecionar o local e nome do arquivo de saída (ex. C:\
Livro_Lidar\ASC\Modelo_Superficie_Exemplo.asc).

29.	 Selecionar a opção ASCII grid file dentro do campo Format e clicar em Export (Figura 14).

Observação: é preciso digitar a extensão .asc no final do nome do arquivo de saída, caso  
contrário o ArcGis não irá localizá-lo.

 
 

Figura 14. Exportação de modelo criado no Fusion da extensão DTM para a extensão ASCII.
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2.4.2. Definição do sistema de projeções de coordenadas em arquivos ASCII 

No ArcGis, o modelo DTM convertido ao formato ASC no Fusion precisa ter os sistemas de 
projeção, coordenada e referência redefinidos, por meio da ferramenta Arctoolbox:

30.	Clicar em Arctollbox > Data Management Tools > Projections e transformations > Define 
Projection. Selecionar a projeção desejada. Para os dados contidos no CD Lidar FEA será 
usado sistema de coordenada UTM, Zona 19S e Datum WGS84 (Figura 15).

31.	Verificar se a imagem criada está com o sistema de referência determinado no comando 
anterior: abrir a janela de propriedades no Modelo_Superficie_Exemplo.asc clicando com 
o botão direito do mouse sobre o arquivo. 

32.	Clicar na aba Source e observar o sistema de projeção no campo Spatial Reference (Figura 
16).

Figura 15. Definição do sistema de projeção de coordenadas (Modelo_Superficie_Exemplo.
asc) no ArcGis, por meio do comando Define Projection.

Figura 16. Verificação do sistema de coordenadas e sistema de referência (Datum) do modelo 
de superfície exportado para o formato ASC.
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2.4.3. Alteração das propriedades de arquivos ASC e raster 

Ao adicionar o raster Modelo_Superficie_Exemplo.asc no Data View do ArcGis, a imagem 
aparece preta, sem graduação por cores. Para melhorar a visualização do arquivo ASC e 
consequentemente interpretar seu conteúdo e fazer novas modelagens, é preciso ajustar sua 
simbologia.

33.	Abrir a janela de propriedades clicando com o botão direito do mouse em cima do nome 
da imagem (ex. Modelo_superficie_Exemplo.asc).

34.	Na aba Layer properties selecionar symbology para definir a graduação de cinza adequada. 

35.	No campo Show, selecionar a opção Stretched.

36.	No campo Tretch selecionar em Type a opção Standard Deviations e n = 2 (Figura 17). A 
imagem deve agora aparecer com os tons de cinza ajustados (Figura 18).

 
 

Figura 17. Edição da simbologia da imagem referente ao modelo de superfície.
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Figura 18. Modelo de superfície após o ajuste dos tons de cinza na simbologia.
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2.4.4. Conversão de arquivos do formato ASCII para raster

Arquivos no formato ASCII importados para o ArcGis devem ser convertidos em arquivos 
raster a fim de facilitar a sua manipulação, edição e análises:

37.	Abrir Arctollbox > Conversion tools > To Raster > ASCII to Raster.

38.	Selecionar, no campo input feature, o arquivo a ser convertido (ex. C:\Livro_Lidar\ASC\
Modelo_Superficie_Exemplo.asc).

39.	Definir o nome e o endereço do arquivo de saída (ex. C:\Livro_Lidar\RASTER\Mod_Superfic) 
no campo Output Raster.

40.	Selecionar a opção Integer no campo Output data type e pressionar Ok (Figura 19).

41.	Definir projeção do arquivo raster Mod_Superfic criado na etapa anterior, seguindo os 
comandos 30 a 32.

 

Figura 19. Conversão do modelo de superfície do formato ASCII para raster (imagem), por 
meio do comando ASCII to Raster do ArcGis.
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3. Microzoneamento florestal 

O microzoneamento é composto pelos modelos topográfico e hidrográfico da área florestal 
que será manejada. A acurácia dos modelos gerados nesta etapa é fundamental para subsidiar 
a fase de planejamento da exploração. Os dados Lidar serão utilizados para modelagem do 
relevo, definição de áreas de acesso restrito, modelagem dos cursos de água e definição da 
área de preservação permanente. Todos esses produtos serão gerados a partir do modelo de 
superfície nua do terreno.

3.1. Modelo de superfície

3.1.1. Filtragem dos pontos da superfície por meio do comando Groundfilter

Para a construção do modelo de superfície serão utilizados somente os pontos Lidar que 
atingiram a superfície do solo. A filtragem desses pontos pode ser feita pelo comando 
Groundfilter. A utilização desse comando demanda alguma experiência do usuário e requer 
que os parâmetros sejam calibrados para a obtenção de resultados consistentes especialmente 
quando se pretende produzir modelos de alta resolução (células menores que 2 m). A linha 
de comando 1 foi construída para a produção de um modelo com resolução de 2 m com os 
dados Lidar que acompanham esta publicação (Filtro_Superficie_Exemplo.bat). Amostras 
Lidar de outras áreas, provavelmente, irão demandar uma calibração diferente dos parâmetros 
desse comando.

Normalmente, pontos filtrados da superfície são fornecidos pelas empresas que prestam 
serviços de aquisição de dados Lidar. Em alguns casos esses pontos são fornecidos no 
formato .XYZ. Arquivos desse tipo podem ser convertidos para a extensão LDA, com os quais 
é possível gerar o modelo de superfície. O procedimento de conversão de arquivos com 
extensão .XYZ ou .ASCII para .LDA segue a rotina abaixo:

Observação: os dados filtrados no formato .XYZ não estão disponíveis no CD Livro_Lidar.

42.	Executar o programa Fusion.

43.	Clicar na opção tools > data conversion > import generic AscII lidar data.

44.	Clicar no primeiro campo chamado browse da janela Import ASCII data.

45.	Selecionar o arquivo a ser convertido. 

46.	Clicar no segundo campo chamado browse e definir o nome e endereço do arquivo de 
saída, na extensão .LAS ou LDA (ex. C:\Livro_Lidar\LAS_LDA\Grid_exemplo.lda).

47.	Clicar em import data. 
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3.1.2. Criação do modelo de superfície por meio do comando Gridsurfacecreate

Com a grade de dados de superfície da área amostra convertida para extensão LDA é possível 
gerar o modelo de superfície (Modelo_Superficie_Exemplo) por meio do comando 
Gridsurfacecreate (linha de comando 2). A edição e execução da linha de comando Modelo_
Superficie_exemplo.bat devem ser feitas conforme os itens 2.1 e 2.2.2.

Após a criação do Modelo_Superficie_Exemplo.dtm no Prompt DOS é possível visualizar o 
modelo de superfície no programa Fusion pela seguinte rotina:

48.	 Abrir o Fusion, clicar em Image e carregar a imagem Amostra_FEA_Exemplo.bpm.

49.	Clicar em Raw data, abrir o arquivo referente à grade de dados Lidar (ex. C:\Livro_Lidar\
LAS_LDA\Grid_Exemplo.Lda) (Figura 20).

50.	Clicar em Bare Earth e selecionar o arquivo (ex. C:\Livro_Lidar\DTM\Modelo_Superficie_
Exemplo.dtm) (Figura 21). 

51.	Selecionar um trecho da imagem e aguardar visualização no programa LDV (Figura 22).

52.	A exportação do arquivo DTM criado para o ArcGis segue os procedimentos descritos no 
item 2.4.1 deste trabalho.

Figura 20. Carregamento da grade de pontos de superfície. 
 

Figura 21. Carregamento do modelo de superfície sobre a imagem da área amostrada.
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Figura 22. Visualização da imagem tridimensional do modelo de superfície da amostra no 
LDV.
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3.2. Modelagem da topografia

O diagnóstico topográfico da área será feito de forma semelhante ao procedimento de 
modelagem do relevo utilizado por Figueiredo et al. (2007), por meio do programa ArcGis. A 
modelagem topográfica ajuda na determinação das áreas de preservação permanentes e na 
tomada de decisão para alocação de pátios, estradas e trilhas de arraste na área de manejo.

A partir do modelo de superfície serão produzidos efeitos de sombreamento (hillshade), 
curvas de nível (contour) e modelos tridimensionais de relevo (TIN) para facilitar a visualização 
e interpretação do relevo da área amostrada.

3.2.1. Geração do efeito de sombreamento

53.	 Clicar em 3D Analist > Spatial Analyst > Hillshade.

54.	Selecionar o arquivo de entrada no campo “Input surface” (ex. C:\Livro_Lidar\ASC\Mod_
Superfic.asc).

55.	Definir os parâmetros do sombreamento: azimute – direção angular do sol (ex. 315°); 
altitude – ângulo da iluminação acima do horizonte (ex. 45°); z-factor 1.

56.	No campo “Output raster” definir o nome e endereço do arquivo resultante (ex. C:\Livro_
Lidar\RASTER\HS_Exemplo) (Figura 23).

3.2.2. Geração do modelo de curvas de nível

57.	Clicar em Arctoolbox > Spatial Analyst Tools > Surface > Contour.

58.	Selecionar o arquivo de entrada no campo Input surface (ex. C:\Livro_Lidar\RASTER\Mod_
Superfic).

59.	No campo Output features definir o nome e endereço do arquivo resultante (ex. C:\Livro_
Lidar\SHAPE\Curvas_Nivel_5m_Exemplo) (Figura 24).

60.	No campo Contour interval selecionar a distância desejada (em metros) entre as cotas das 
curvas de nível (no exemplo 5 metros).

61.	Nos campos Base contour e Z factor manter os valores de 0 e 1, respectivamente.

3.2.3. Geração da rede triangular irregular – TIN

62.	Clicar em 3D Analist > Create/Modify TIN > Create TIN from feature.

63.	No campo Layers, selecionar o shape gerado no item anterior (ex. Curvas_Nivel_5m_
Exemplo.shp).

64.	No campo Height source selecionar Contour. 

65.	No campo Triangulate as selecionar hard line ou soft line.

No campo Output TIN definir o nome e endereço do arquivo resultante (ex. C:\Livro_Lidar\
RASTER\Tin_Exemplo). O modelo TIN gerado a partir dos dados usados como exemplo é 
apresentado na Figura 25.
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Figura 23. Modelo de superfície com efeito de sombreamento (hillshade) com escala de cinza 
de 0 a 256 e parâmetros: azimute 315° (direção angular do sol); altitude 45° (ângulo da 
iluminação acima do horizonte); z-factor 1.
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Figura 24. Modelo de superfície com curvas de nível com intervalo de 5 metros.
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Figura 25. Imagem TIN (Triangular Irregular Network) gerada a partir do modelo de superfície.
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3.3. Áreas de acesso restrito

Áreas de acesso restrito são aquelas onde os aclives e declives do terreno devem ser evitados 
para passagem de estradas, construção de pátios e arraste de toras. Valores de restrição são 
normalmente apresentados na forma de percentuais que variam de acordo com a especificação 
técnica das máquinas usadas, tipo de solo e regime de chuvas. Nesse exemplo, foi considerada 
como declividade máxima aceitável para construção de estradas equivalente a 15%. A geração 
desse modelo será feita por meio da ferramenta Slope do ArcGis. Os valores adotados para 
a divisão da declividade em classes são: classe 1 de 0% a 14,9% (adequada para a construção 
de infraestrutura e passagem de máquinas) e classe 2 com declividade igual ou superior a 
15%.

Observação: para que a camada Slope a ser gerada possa ter suas propriedades alteradas, é 
necessário que o raster modelo de superfície utilizado tenha sido gerado com a opção 
INTEGER selecionada na janela Output data type da ferramenta ASCII to Raster, para evitar 
que a mensagem “Too many unique values (> 70000)” apareça quando a geração de 
histograma dos valores únicos for iniciada após a opção de classificação (Classified) ter sido 
selecionada.

66.	Clicar em 3D Analyst > Surface Analysis > Slope.

67.	Selecionar o arquivo de entrada no campo Input surface (ex. C:\Livro_Lidar\RASTER\
Modelo_Superfic).

68.	Selecionar no campo Output raster a pasta e o nome do arquivo de saída (ex. C:\Livro_
Lidar\RASTER\Slope_exemplo).

69.	Selecionar no campo Output measurement a opção Percent_rise, caso queira valores de 
declividade em percentagem, ou Degree para valores em graus. Nesse exemplo, adotar a 
opção Percent_rise.

70.	Nos campos Z Factor e Output cell size, sugere-se que seja mantido o valor 1 em ambos 
os casos (Figura 26).

Para converter a imagem Slope_exemplo em polígono, é necessário fazer, primeiramente, o 
procedimento de renderização. Em seguida será gerado o shape de área restrita para áreas 
com declividade igual ou superior a 15%.

71.	Editar a imagem gerada (Slope_exemplo) para classificação dos dados em duas classes 
(classe 1 de 0% a 14,9% e classe 2 igual ou acima de 15%): Layer Properties > Symbology> 
Classified > Classification > Classes = 2 (Figura 27). Pressione Classify e na janela Break 
Values digite o valor 14,99 para a primeira classe, pressione Ok para fechar a janela de 
classificação e Ok novamente para aplicar as mudanças nas propriedades da camada 
(Layer properties). 

72.	Clicar com o botão direito sobre o layer da imagem (slope) > Data > Export Data.

73.	Na janela Export Raster Data, manter as opções Raster Data Set (Original) selecionadas 
nas janelas Extent e Spacial Reference e habilitar a opção Use Renderer na janela Output 
Raster.

74.	Selecionar no campo Location a pasta onde o arquivo será salvo (ex. C:\Livro_Lidar\
RASTER).

75.	Selecionar no campo Name o nome do arquivo: slope_render.

76.	Selecionar no campo Format a extensão da imagem (IMAGINE).
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77.	Clicar em Save.

As áreas de acesso restrito receberão o valor 1 que representa pixels com declividade igual 
ou superior a 15%. Áreas com declividade inferior a 15%, recomendadas para o planejamento 
e construção da rede de estradas e pátios de estocagem, receberão o valor 0 na imagem.

78.	No Spatial analyst selecionar Reclassify. No campo Input raster selecionar a imagem 
Slope_render. No campo New values selecionar NoData para o campo 0 e para o campo 1 
o valor 1. No campo Output raster  definir o nome e endereço do arquivo (ex. C:\Livro_
Lidar\RASTER\Slope_class). 

79.	Abrir Arctoolbox>Conversion Tools>From Raster>Raster to Polygon.

80.	Selecionar no campo Input raster a imagem slope_class.img.

81.	Definir no campo Output polygon feature o endereço e nome de arquivo (ex. C:\Livro_
Lidar\SHAPE\Area_restrita_15_porcento.shp) (Figura 28).

82.	Manter a opção Simplify polygons (optional) habilitada e clicar Ok. 

Apenas os valores iguais ou acima de 15% de declividade serão usados para a construção do 
polígono Área Restrita (Figura 29).

Outra forma de definir áreas restritas é pela metodologia descrita em Figueiredo et al. (2007, 
cap. 7, p. 135-137). Nela, as áreas restritas são definidas pelo intervalo de cotas das curvas de 
nível, distância horizontal entre curvas e declividade a ser considerada restritiva.  
 

 
Figura 26. Produção do modelo de declividade (slope_exemplo) por meio do comando Slope 
do ArcGis. 
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Figura 27. Classificação da imagem slope_exemplo em duas classes de declividade: até 14,9% 
e acima deste valor.

Figura 28. Conversão de raster (slope_render) em polígono por meio do comando Raster to 
Polygon do ArcGis.
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Figura 29. Áreas de acesso restrito definidas como declividade igual ou superior a 15%. 
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3.4. Modelagem da hidrografia

A modelagem da hidrografia consiste na determinação dos cursos de água por meio do 
modelo de superfície com uso da ferramenta Hydrology do programa ArcGis. A metodologia 
utilizada foi baseada em Figueiredo et al. (2007) e McGaughey (2010).

3.4.1. Remoção de anomalias e inconsistências topográficas da imagem com uso da   
ferramenta Fill

83.	Abrir o modelo (ex. C:\Livro_Lidar\ASC\Modelo_Supericie_Exemplo.asc) no ArcMap.

84.	Abrir a ferramenta Arctoolbox > Spatial Analyst Tools > Hydrology > Fill.

85.	Selecionar em Input surface raster o arquivo (ex. C:\Livro_Lidar\ASC\Modelo_Superficie_
Exemplo.asc).

86.	Nomear o arquivo de saída (ex. C:\Livro_Lidar\RASTER\Fill_Exem).

87.	Deixar o campo Z limit em branco e pressionar Ok (Figura 30).

3.4.2. Definição da direção de fluxo de água com uso da ferramenta Flow direction 

88.	Abrir a ferramenta Arctoolbox > Spatial Analyst Tools > Hydrology > Flow direction.

89.	Selecionar a imagem criada na etapa anterior C:\Livro_Lidar\RASTER\Fill_Exemplo.

90.	Nomear o arquivo de saída (ex. C:\Livro_Lidar\RASTER\FlowDir_Exem) no campo Output 
flow directon raster.

91.	Manter o campo Force all edge cell to flow outward (optional) e Output drop raster (optical) 
em branco. Pressionar Ok (Figura 31).

3.4.3. Definição da bacia de acumulação da rede de drenagem com uso da ferramenta Flow 
accumulation  

92.	Abrir a ferramenta Arctoolbox > Spatial Analyst Tools > Hydrology > Flow accumulation.

93.	Selecionar a imagem criada na etapa anterior (ex. C:\Livro_Lidar\RASTER\FlDir_Exemplo) 
no campo Input flow direction raster.

94.	Nomear o arquivo de saída (ex. C:\Livro_Lidar\RASTER\FlowAcc_Exem) no campo Output 
accumulation raster.

95.	Deixar o campo Input weight raster (optional) em branco, manter FLOAT no campo Output 
data type e pressionar Ok (Figura 32).

3.4.4. Determinação dos valores mínimos para bacia de acumulação

96.	Selecionar a ferramenta Spatial analyst > Raster calculator >.

97.	Criar o arquivo com valores mínimos de acumulação (ex. C:\Livro_Lidar\RASTER\FlowMin_
Exem) de acordo com a fórmula:

FlowMin_Exem = con([FlowAcc_Exem] > 7000, 1).

98.	Pressionar Evaluate (Figura 33).
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3.4.5. Definição da ordem dos cursos de água com uso da ferramenta Stream order

99.	Abrir a ferramenta Arctoolbox > Spatial Analyst Tools > Hydrology > Stream Order.

100.	 Selecionar a imagem criada na etapa anterior	 (ex. C:\Livro_Lidar\RASTER\FlowMin_		
	 Exem) no campo Input stream raster.

101.	 Selecionar o modelo de direção do fluxo d’água (ex. C:\Livro_Lidar\RASTER\FlowDir_	
	 Exem) no campo Input flow direction raster.

102.	 Nomear o arquivo de saída (ex. C:\Livro_Lidar\RASTER\Stream_Exem) no campo 		
	 Output  raster.

103.	 Manter o método de SHREVE no campo Method of stream ordering (optional) e clicar 	
	 em Ok.

3.4.6. Transformação da imagem que representa a ordem dos cursos de água em um arquivo 
shape por meio do comando Stream to feature 

104.	 Clicar em Arctoolbox > Spatial Analyst Tools > Hydrology > Stream to feature.

105.	 No campo Input stream raster, selecionar o arquivo gerado na etapa anterior (ex. C:\	
	 Livro_Lidar\RASTER\Stream_Exem).

106.	 No campo Input flow direction raster selecionar o arquivo de fluxo de direção da água 	
	 (ex. C:\Livro_Lidar\RASTER\FlowDir_Exem).

107.	 No campo Output polyline feature nomear e salvar o arquivo de hidrografia (ex. C:\		
	 Livro_Lidar\SHAPE\Modelo_Hidro_Exemplo.shp).

108.	 Marcar a opção Simplify polyline (optional) e pressionar Ok (Figura 34).
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Figura 30. Remoção de anomalias e inconsistências topográficas da imagem por meio da 
ferramenta Fill.
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Figura 31. Definição da direção do fluxo d’água por meio da ferramenta Flow direction.
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Figura 32. Definição da bacia de acumulação da rede de drenagem por meio da ferramenta 
Flow accumulation.
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Figura 33. Detalhe da janela da ferramenta Raster Calculator, usada para a determinação dos 
valores mínimos para bacia de acumulação.

Figura 34. Modelo da hidrografia gerado a partir do modelo de superfície.
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3.5. Definição das áreas de preservação permanente (APP)

As áreas de preservação permanente serão determinadas a partir dos modelos de relevo e 
hidrografia criados, obedecendo aos critérios estabelecidos pela lei florestal vigente (BRASIL. 
Lei nº 12.651/2012), criando áreas tampão em torno de rios, igarapés e trechos do terreno com 
inclinação superior a 45°.

3.5.1. APP de cursos de água

As áreas de preservação permanente em torno da rede de drenagem serão determinadas a 
partir do modelo criado no item anterior, obedecendo aos critérios estabelecidos pela lei 
florestal vigente (BRASIL. Lei nº 12.651/2012), criando zonas tampão em torno de rios e 
igarapés, por meio do uso da ferramenta Buffer do Arctoolbox (Tabela 2). 

 
Tabela 2. Limite de área de preservação permanente para cursos de água e nascente conforme 
novo código florestal brasileiro. 

Largura do curso de água (metros) Faixa de APP (metros) Buffer (metros)

Até 10 30 ½ calha do rio + 30

De 10 a 50 50 ½ calha do rio + 50

De 50 a 200 100 ½ calha do rio + 100

De 200 a 600 200 ½ calha do rio + 200

Acima de 600 500 ½ calha do rio + 500

Nascente (ponto) 50 (raio) 50

109.	 Clicar em Arctoolbox > Analysis Tools > Proximity > Buffer.

110.	 No campo Input Features selecionar o modelo de hidrografia (ex. C:\Livro_Lidar\		
	 SHAPE\Modelo_hidro_Exemplo.shp).

111.	 No campo Output Feature Class nomear o arquivo que representará as áreas de APP 	
	 em torno da rede hidrográfica (ex. C:\Livro_Lidar\SHAPE\APP_Modelo_Hidro_Exemplo).

112.	 No campo Distance (Value or field) habilitar a opção Linear unit e preencher com a 		
	 largura de uma das margens da APP. 

113.	 Manter as opções FULL no campo Side Type, ROUND no campo End Type e ALL no 		
	 campo Dissolve Type e pressionar Ok (Figura 35).

No caso do exemplo, essa largura foi de 30 metros, pois os cursos de água na área de estudo 
não ultrapassam 10 metros de largura. Quando a largura da calha do igarapé ou rio é 
conhecida, sugere-se que a largura do buffer seja calculada como sendo a soma da metade 
da largura da calha mais a faixa de APP de 30 metros. 
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Figura 35. Área de preservação permanente, definida a partir do modelo de hidrografia para 
cursos de água de até 10 metros. 
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3.5.2. APP de nascentes

Ainda de acordo com o novo código florestal, são áreas de preservação permanente 50 
metros no entorno de nascentes e olhos-d’água. Para criar os pontos representativos das 
nascentes será utilizada a ferramenta XtoolsPro e para criar a zona tampão em torno das 
nascentes será utilizada a ferramenta Buffer do Arctoolbox.

114.	 Clicar em XtoolsPro> Feature Conversions>Convert Features to points.

115.	 Selecionar Modelo_Hidro_Exemplo.asc em Input feature layer.

116.	 Definir o nome e endereço do arquivo de saída (ex. C:\Livro_Lidar\SHAPE\Nascentes_	
	 Exemplo.shp).

117.	 Na subjanela Points selecionar End points>From (habilitado) e To (desabilitado) e 		
	 pressionar Ok (Figura 36).

118.	 Clicar em Arctoolbox > Analysis Tools > Proximity > Buffer.

119.	 No campo Input Features, selecionar o arquivo (ex. C:\Livro_Lidar\SHAPE\Nascentes_	
	 Exemplo.shp).

120.	 No campo Output Feature Class nomear o arquivo que irá representar as APPs das 		
nascentes (ex. C:\Livro_Lidar\SHAPE\APP_Nascente_exemplo).

121.	 No campo Distance (Value or field), habilitar a opção Linear unit e preencher com a 		
	 largura de uma das margens da APP, que será de 50 metros nesse caso. 

122.	 Manter as opções FULL no campo Side Type, ROUND no campo End Type e ALL no 		
	 campo Dissolve Type e pressionar Ok. 

Essa sequência cria pontos em todas as extremidades finais do modelo da hidrografia feito 
anteriormente. Os pontos criados não necessariamente representam nascentes. Recomenda-
se que a seleção desses pontos seja feita com base na experiência do técnico com a área de 
estudo ou que sejam feitas visitas de campo para confirmar a existência das nascentes criadas 
e verificar possíveis nascentes em locais não modelados por essa metodologia. É necessário 
também retirar os pontos de nascentes criados em lugares inadequados, como no meio do 
curso de água e em bifurcações da hidrografia. Após a verificação e edição manual dos pontos 
incorretos, faz-se a APP das nascentes (Figura 37).
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Figura 36. Ferramenta de conversão de feição em pontos do ArcGis (Convert Features to 
Points) utilizada para criar os pontos referentes às nascentes dos cursos de água.
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Figura 37. Área de preservação permanente para nascentes. 
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3.5.3. APP hidrografia

Para produzir a área de preservação permanente da hidrografia dessa área de estudo, deve-
se unir as duas APPs (APP_Modelo_Hidro_Exemplo.shp e APP_Nascentes_Exemplo.shp), 
com a ferramenta Union e em seguida usar a ferramenta Merge para juntar os respectivos 
atributos e, por fim, usar a ferramenta Clip para recortar os fragmentos de APP que estão fora 
do shape Poligono_Exemplo (ex. C:\Livro_Lidar\SHAPE\APP_Hidro_Exemplo.shp) (Figura 38).

123.	 Clicar em Arctoolbox > Analysis Tools > Overlay > Union.

124.	 Adicionar os arquivos APP_Modelo_Hidro_Exemplo.shp e APP_Nascentes_Exemplo.	
	 shp em Input feature layer.

125.	 Definir o nome e endereço do arquivo de saída (ex. C:\Livro_Lidar\SHAPE\APP_union_	
	 exemplo.shp).

126.	 Clicar em Editor e iniciar a edição no botão Start editing.

127.	 Clicar com o botão direito sobre o layer APP_union_exemplo (na janela de camadas do 	
	 Arcmap) e clicar em Selection > Select All.

128.	 Clicar em Editor > Merge > Ok.

129.	 Clicar em Arctoolbox > Analysis Tools > Extract > Clip.

130.	 No campo Input Features, selecionar o arquivo da APP unida (ex. C:\Livro_Lidar\		
	 SHAPE\	APP_union_exemplo.shp).

131.	 No campo Clip Feature Class selecionar o polígono da área de estudo (ex. C:\Livro_		
	 Lidar\SHAPE\Poligono_exemplo).

132.	 Definir o nome e endereço do arquivo de saída no campo Output Feature Classe (ex. 	
	 C:\Livro_Lidar\SHAPE\APP_Hidro_exemplo.shp).
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Figura 38. Área de preservação permanente final para a hidrografia da área da amostra. 
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3.5.4. APP de relevo

De acordo com a lei florestal, áreas de encostas ou partes destas com declividade superior a 
45° são classificadas como APPs. A determinação dessas áreas será feita a partir do modelo 
de relevo produzido no item 3.1, por meio da ferramenta Slope. Após a produção da imagem 
Slope, serão definidas duas classes de valores de declividade: maior ou menor que 45°. Em 
seguida, a imagem será renderizada para então ser convertida em um arquivo de polígono, 
com o qual será possível produzir a APP de relevo.

3.5.4.1. Geração da imagem raster da APP de relevo

133.	 Clicar em Arctoolbox > Spatial Analyst Tools > Surface > Slope.

134.	 Selecionar no campo Input surface, o arquivo de superfície (ex. C:\Livro_Lidar\RASTER\	
	 Mod_Superfic).

135.	 Selecionar no campo Output measurement, a opção Percent caso queira valores de 		
	 declividade em percentagem ou Degree, para valores em graus. Nesse exemplo, 		
	 adotar 	a opção Degree.

136.	 Nos campos Z Factor e Output cell size, manter o valor 1 em ambos.

137.	 Selecionar no campo Output raster a pasta e o nome do arquivo de saída (ex. C:\Livro_	
		  Lidar\RASTER\Slope45_Exem) (Figura 39).

138.	 Editar a imagem gerada no passo anterior para divisão em duas classes, uma de 0° a 	
	 44,9° e outra acima de 45°: Layer Properties > Symbology> Classified > Classification > 	
	 Classes 2, I (Figura 40).

139.	 No diretório de camadas (layers) em uso, clicar com o botão direito sobre o nome da 	
	 imagem gerada no item anterior e selecionar > Data > Export Data.

140.	 Na janela Export Raster Data, manter as opções Raster Data Set (Original) selecionadas 	
	 nas janelas Extent e Spacial Reference e habilitar a opção Use Renderer. 

141.	 Selecionar no campo Location a pasta onde o arquivo será salvo (ex. C:\Livro_Lidar\		
	 RASTER).

142.	 Selecionar no campo Name o nome do arquivo a ser gerado (Slope_rdr_Exem.img).

143.	 Selecionar no campo Format a extensão da imagem (IMAGINE).

144.	 Clicar em Save (Figura 41).

3.5.4.2. APP para declividade igual ou maior que 45° 

Na imagem Slope_rdr_Exem, as áreas com declividade maior ou igual a 45° receberam o 
valor 1 e as áreas com declividade inferior a 45°, o valor 0. Todos os pixels demarcados com 
o valor 1 são considerados APPs, sem necessidade de criação de buffers, entretanto, estes 
precisam ser convertidos em polígono.

145.	 Abrir a tabela de atributos da imagem Slope_rdr_Exem.img e selecionar toda a linha 	
	 com valor 1 no campo Value.

146.	 Clicar em Arctoolbox > Convertion tools > Raster to polygon.

147.	 Selecionar o raster gerado no item anterior (ex. C:\Livro_Lidar\RASTER\Slope_rdr_		
	 Exem) no campo input raster.
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148.	 Manter value no campo Field (optional).

149.	 Selecionar no campo Output polygon feature o endereço e nome (ex. C:\Livro_Lidar\	
	 SHAPE\APP_45graus_Exemplo.shp).

150.	 Desmarcar a opção simplify polygons e clicar Ok (Figura 42). Após a execução desse 	
	 comando, as áreas com declividade acima de 45° aparecerão na tela do computador 	
	 no formato shape. Na área usada como exemplo apenas uma pequena parte possui 	
	 essa característica (Figura 43).

 

Figura 39. Ferramenta Slope para produção de imagem de declividade a partir do modelo de 
superfície.

Figura 40. Propriedades da imagem Slope criada, com divisão em duas classes de declividade 
em graus.
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Figura 41. Procedimento de renderização de um raster (Slope_45_exem) por meio da 
ferramenta Export Raster Data do ArcGis.

Figura 42. Conversão da imagem Slope_rdr_exem.img para polígono por meio do comando 
Raster to Polygon do ArcGis.
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Figura 43. Modelo de superfície com áreas de declividade maior ou igual a 45° (polígonos 
vermelhos) definidas pela legislação florestal como áreas de preservação permanente. 
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3.5.5. APP total

A área de preservação permanente total equivale ao somatório das áreas de preservação 
permanente da hidrografia e declividade maior que 45°. A união dos modelos de APP será 
feita por meio da ferramenta Arctoolbox > Analysis Tools > Overlay > Union.

151.	 Selecionar no campo Input feature, os arquivos referentes às APPs de rede de 		
	 drenagem (C:\Livro_Lidar\SHAPE\APP_Hidro_Exemplo.shp) e APP de declividade (ex. 	
	 C:\Livro_Lidar\SHAPE\APP_45graus_exemplo.shp).

152.	 Selecionar o campo Output feature class e nomear o arquivo de saída (ex. C:\Livro_		
	 Lidar\SHAPE\APP_Final_Exemplo.shp) (Figura 44).
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Figura 44. Área de preservação permanente total, feita a partir da união das áreas de 
preservação permanente de hidrografia (verde) e declividade (vermelho). 
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4. Modelos de dossel

4.1. Modelo de superfície de dossel

O modelo de superfície de dossel é composto por todos os retornos úteis da amostra feita 
pelo Lidar, que estão presentes no contorno do dossel da floresta amostrada com suas 
respectivas elevações em relação ao nível do mar. A criação do modelo digital de dossel será 
feita na base MS-DOS, por meio do comando Canopymodel do Fusion, e poderá ser visualizado 
no programa PDQ Data Viewer (Figura 45).

A linha de comando para a geração do modelo de superfície de dossel é apresentada na linha 
de comando 3. A edição do arquivo .BAT (ex. C:\Livro_Lidar\BAT_Files\Modelo_Superficie_
Dossel.bat) com os parâmetros do modelo e a execução da linha de comando serão feitas 
conforme os itens 2.3 e 2.4 deste trabalho. A exportação do arquivo DTM criado para o ArcGis 
segue os procedimentos descritos no item 2.5 deste trabalho. Na Figura 46 consta a visualização 
do modelo de superfície de dossel gerado com as amostras de Lidar do livro no ArcGis.
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Figura 45. Representação tridimensional do modelo de superfície do dossel no programa 
PDQ Data Viewer Version 1.82.
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Figura 46. Imagem do modelo de superfície de dossel no formato ASC no ArcGis. 
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4.2. Modelo de altura do dossel

O modelo de altura do dossel é gerado pelo comando Canopyheightmodel (CHM) do programa 
Fusion, adicionado do parâmetro ground, que faz a normalização das elevações da superfície 
tornando o terreno plano. Com esse procedimento é possível comparar as alturas das copas 
de árvores individuais, estimar (em diferentes alturas) e fazer comparações multitemporais 
da cobertura vegetal da floresta amostrada.

A linha de comando para a geração do modelo de altura do dossel é apresentada na linha de 
comando 4. A edição do arquivo .BAT com os parâmetros do modelo (ex. C:\Livro_Lidar\
BAT_Files\Modelo_Altura_Dossel.bat) e a execução da linha de comando serão feitas conforme 
os itens 2.3 e 2.4 deste trabalho. A exportação do arquivo DTM, criado para o ArcGis, segue 
os procedimentos descritos no item 2.5 deste trabalho. O modelo gerado pode ser visualizado 
no formato DTM no programa PDQ Data Viewer (Figura 47) ou no formato raster no ArcGis 
(Figura 48).
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Figura 47. Representação tridimensional do modelo de altura do dossel no programa PDQ 
Data Viewer.
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Figura 48. Imagem do modelo de altura do dossel convertido em .ASC projetado no ArcGis. 
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4.3. Estimativa da área de cobertura de dossel

A partir do modelo de altura de dossel exportado para o ArcGis, modelos de cobertura 
vegetal a diferentes alturas acima da superfície podem ser criados. Esses modelos são 
usados para estimar parâmetros estruturais da floresta e comparar áreas de cobertura 
vegetal antes e após a exploração.

A estimativa da área de cobertura da vegetação pode ser feita em diferentes alturas do 
dossel (ex. 30 m) pela eliminação dos dados Lidar abaixo dessa altura. Para a execução da 
filtragem dos dados, será utilizada a ferramenta Spatial Analist > Raster Calculator do 
ArcGis.

153.	 Abrir a imagem do modelo de altura de dossel (ex: C:\Livro_Lidar\ASC\Modelo_Altura_	
	 Dossel_exemplo.asc).

154.	 Especificar o endereço onde as imagens geradas pelo raster calculator serão salvas 	
	 selecionando Spatial Analist > Options.

155.	 Selecionar a ferramenta Spatial Analyst > Raster Calculator.

156.	 Na janela aberta digitar o nome do arquivo de saída escolhido (ex. Cobertura_30).

157.	 Digitar o comando (considerar os espaços em branco na sintaxe): 

Cobertura_30 = con([Modelo_Altura_Dossel_exemplo] >= 30, 1) (Figura 49).

Onde:

con = uma condição deve ser satisfeita pelo arquivo de saída.

Modelo_altura_dossel_exemplo.asc = modelo de altura de dossel em uso, selecionado por 
um duplo clique com o botão direito do mouse sobre o nome do arquivo na janela layers.

 > = 30 = condição a ser atendida. No caso, altura deverá ser igual ou superior a 30 m.

, 1 = apenas valores que satisfaçam a condição (verdadeiro) serão usados para a criação do 	
 raster.

Observação: para que o arquivo Cobertura_30 seja salvo na pasta C:\Livro_Lidar\RASTER é 
preciso configurar esse endereço nas opções da ferramenta Spacial Analyst.

4.3.1. Conversão da imagem Cobertura_vegetal_30 gerada em polígono

Esse procedimento possibilita o cálculo da área do polígono gerado. A conversão é feita por 
meio da ferramenta Arctoolbox > Conversion Tools > From Raster > Raster to Polygon.

158.	 Selecionar o arquivo de entrada que será convertido em polígono (ex. C:\Livro_Lidar\	
	 RASTER\Cobertura_30).

159.	 Definir o nome e endereço do arquivo de saída (ex. C:\Livro_Lidar\ SHAPE \Cobertura_	
	 Vegetal_Exemplo_30.shp).

160.	 Manter VALUE no campo Field (optional) e desmarcar a opção Simplify polygons 		
	 (optional).

161.	 Calcular a área do polígono: Spatial analyst tools > Utilities > Calculate Areas. Na caixa 	
	 Input Feature Class selecionar o polígono de entrada (ex. Cobertura_Vegetal_			
	 Exemplo_30.shp) e na caixa Output Feature Class o arquivo de saída (ex. Cobertura_	
	 Vegetal_30_Area.shp) e pressionar Ok (Figura 50). 
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Figura 49. Janela Raster Calculator com o algoritmo para geração de cobertura de copas 
acima de 30 metros.
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Figura 50. Modelo de altura de dossel somente com a cobertura de copas acima de 30 metros. 
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4.4. Comparação multitemporal da área de cobertura vegetal de uma floresta 

Quando duas ou mais amostras de Lidar são obtidas, cobrindo a mesma área em tempos 
diferentes, é possível comparar a variação na cobertura de vegetação a uma determinada 
altura dessa área. Esse modelo pode ser usado de forma a avaliar os impactos produzidos 
por causas naturais (ventos, secas ou mesmo incêndios florestais) ou antrópicas no caso de 
mudança no uso da terra ou exploração florestal. Para ilustrar essa seção, foram usadas duas 
amostras tomadas antes (2010) e após a exploração (2011), visando avaliar o impacto produzido 
no dossel pelas operações florestais.

Para que as mudanças ocorridas na cobertura de copas sejam observadas, o modelo de altura 
do dossel da primeira amostra (antes da exploração) deverá ser subtraído do modelo de 
altura do dossel da segunda medição no ArcGis. A diferença entre os modelos representa a 
perda de cobertura vegetal no período. Para melhor visualizar o efeito na perda ou ganho de 
cobertura de copas produzida pela exploração, a exemplo do que foi feito na seção 4.3, um 
limite de altura mínimo será arbitrado como parâmetro para a mensuração desse efeito. O 
raster resultante representa copas de árvore da primeira medição que foram cortadas ou 
danificadas pelas operações florestais (Figuras 52 a 54).

4.4.1. Subtração dos modelos de altura do dossel e seleção da altura mínima para avaliação 
da perda de cobertura vegetal

A subtração é feita por meio da ferramenta Arctoolbox > 3D Analyst Tools > Raster Math > 
Minus.

162.	 No campo Input raster or constant value 1 selecionar o C:Livro_Lidar\ASC\Modelo_		
	 Altura_Dossel_Exemplo.asc, referente à amostra de 2010 (antes da exploração), e no 	
	 campo raster or constant value 2 a imagem C:\Livro_Lidar\RASTER\Modelo_Altura_		
	 Dossel_2012.asc referente à segunda amostra (após a exploração).

163.	 Nomear o arquivo de saída (no exemplo C:\Livro_Lidar\RASTER\Mod_Alt_Dif) e teclar 	
	 Ok (Figura 51).

164.	 Abrir a imagem da subtração dos modelos de altura de dossel (ex. C:\Livro_Lidar\		
	 RASTER\Mod_Alt_Dif).

165.	 Especificar o endereço onde a imagem gerada pelo raster calculator será salva 		
	 selecionando Spatial Analist > Options.

166.	 Selecionar a ferramenta Spatial Analyst > Raster Calculator.

167.	 Na janela aberta digitar o nome do arquivo de saída escolhido (ex. Mod_Alt_Dif10).

168.	 Digitar o comando (considerar os espaços em branco na sintaxe): 

Mod_Alt_Dif10 = con([Mod_Alt_Dif] >= 10, 1).

A imagem resultante representa a diferença na cobertura de copas entre os dois 			 
modelos para árvores acima de 10 m de altura (Figura 52).

4.4.2. Cálculo da área de cobertura vegetal afetada pela exploração 

169.	 O primeiro passo é a conversão da imagem gerada em polígono. Esse procedimento 	
	 possibilita o cálculo da área do polígono gerado. A conversão é feita por meio da 		
	 ferramenta Arctoolbox > Conversion Tools > From Raster > Raster to Polygon. 
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170.	 Selecionar o raster de entrada que será convertido em polígono (ex. C:\Livro_Lidar\	
	 RASTER\ Mod_Alt_Dif10).

171.	 Definir o nome e endereço do arquivo de saída (ex. C:\Livro_Lidar\SHAPE\ Mod_Alt_	
	 Dif10.shp).

172.	 Manter a opção COUNT no campo Field (optional), desmarcar a opção Simplify 		
	 polygons (optional) e pressionar Ok.

173.	  Calcular a área do polígono (Mod_Alt_Dif10.shp) por meio da ferramenta Calculate 	
	 Areas (Xtools Pro ou Arctoolbox).

174.	 Selecionar Arctoolbox > Spatial Statistics Tolls > Utilities >Calculate Areas.

175.	 Selecionar o polígono que terá sua área calculada na janela Input Feature Class.

176.	 Escolher o endereço e nome do arquivo de saída (ex. Mod_alt_dif10_area.shp) na 		
	 janela	Output Feature Class e pressionar Ok.

177.	 Áreas pequenas, que não representam danos significativos ou mesmo produzidos 	
	 pela exploração, podem ser excluídas do polígono.

178.	 Na tabela de atributos selecionar a coluna que representa a área do polígono e com o 	
	 botão direito do mouse selecionar sort descending.

179.	 Selecionar todos os polígonos de interesse (no exemplo acima de 10 m2).

180.	 Sobre a janela de layer, clicar sobre o arquivo com o botão direito do mouse e 		
	 selecionar Data .> Export Data e na janela selecionar nome e diretório para o 		
	 arquivo resultante (no exemplo C:\Livro_Lidar\SHAPE\Modelo_altura_dossel_		
	 diferenca_min10m.shp) (Figura 53).

181.	 Para calcular a percentagem de área coberta em relação à área total basta dividir a 	
	 área do polígono pela área total amostrada.

 

Figura 51. Ferramenta Minus utilizada para obtenção da diferença entre os modelos de altura 
do dossel antes e depois da exploração florestal.
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Figura 52. Resultado da subtração da cobertura de vegetação dos modelos de altura do dossel 
produzidos com dados Lidar de 2010 e 2012, mostrando em vermelho área de copa igual ou 
acima de 10 metros de altura removida ou danificada pelas operações florestais. 
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Figura 53. Representação das copas com área igual ou acima de 10 m2 removidas ou danificadas 
pelas operações florestais.
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Figura 54. Modelo com a cobertura vegetal removida ou danificada por operações florestais 
entre o primeiro (2010) e segundo (2012) voo Lidar na área amostrada.
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5. Identificação, medição e monitoramento de operações florestais

Nesta seção serão apresentados modelos para estimar a densidade relativa de vegetação em 
camadas do sub-bosque. Esse modelo permite também localizar e estimar as áreas alteradas 
pela atividade florestal nessas camadas.

5.1. Modelo de densidade relativa de vegetação – RDM 

Este modelo calcula a densidade relativa da vegetação em uma camada do estrato florestal 
previamente selecionada. A camada é definida por um limite inferior e superior de altura. 
Todos os pontos acima do limite superior de altura estabelecido são desconsiderados. 

O cálculo da densidade de vegetação relativa é feito pela divisão do número de pontos dentro 
da camada selecionada pelo número total de pontos a partir da superfície até o limite superior 
da camada (Figura 55). 

A linha de comando para a geração do modelo de densidade relativa de vegetação é 
apresentada na linha de comando 5. A edição do arquivo .BAT com os parâmetros do modelo 
(ex. C:\Livro_Lidar\BAT\Modelo_Vegetacao_Relativa_Exemplo.bat) e a execução da linha de 
comando serão feitas conforme os itens 2.3 e 2.4 deste trabalho. A exportação do arquivo 
DTM criado para o ArcGis segue os procedimentos descritos no item 2.5 deste trabalho. 

Na imagem produzida os pixels em preto representam a densidade relativa de vegetação 
semelhante a zero na camada selecionada (no exemplo altura mínima de 1 m e máxima de 5 
m). A ausência de vegetação revela as áreas alteradas naturalmente ou por operações 
florestais. Essas áreas contínuas serão usadas como referência para a definição das áreas 
alteradas pelas operações florestais (Figura 56). Dessa forma, será possível identificar a 
infraestrutura construída na floresta (estradas e pátios de estocagem) e perturbações 
promovidas pelo corte das árvores (clareiras) e extração das toras (trilhas de arraste).
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5 m

1 m

Nível da superfície do DTM

14 retornos acima de 5 m
(desconsiderado)

10 retornos acima de 5 m

3 retornos abaixo de 1 m

Valor RDM = (10/13) * 100

Figura 55. Representação gráfica do cálculo da densidade relativa de vegetação (RDM) em 
cada célula do modelo.

Fonte: d’Oliveira et al. (2012).
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Figura 56. Imagem do modelo de densidade relativa de vegetação (RDM), mostrando em 
preto áreas alteradas pela abertura de estradas, pátios de estocagem, trilhas de arraste e 
clareiras produzidas pelo corte e extração das árvores. 
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5.2. Definição das zonas tampão de áreas alteradas por operações florestais

No modelo RDM produzido no item anterior pode-se observar, além das perturbações 
promovidas pela exploração florestal, a existência de perturbações naturais como clareiras 
produzidas pela queda de árvores, devido à ação dos ventos, distribuídas por toda a área de 
estudo. As zonas tampão que serão determinadas nesta seção representam os limites dentro 
dos quais as alterações produzidas na vegetação são causadas pelas operações florestais. 

As zonas tampão serão criadas em dois passos: a) criação de arquivos no formato “shape” 
seguida de vetorização de estradas, pátios de estocagem, trilhas de arraste e clareiras; e b) 
criação de zonas tampão (buffers) ao redor desses “shapes” definindo a área de maior 
probabilidade da alteração na vegetação ter sido realmente produzida pelas operações 
florestais.

5.2.1. Vetorização dos arquivos de referência para estradas, pátios, trilhas de arraste e clareiras

182.	 Clicar em ArcCatalog.

183.	 Criar quatro arquivos no formato shape na pasta de trabalho escolhida (ex. C:\Livro_	
	 Lidar\SHAPE\) no mesmo datum e sistema de coordenadas da amostra Lidar (Projeção 	
	 UTM e Datum WGS 84 Zona 19S). 

•	 Estradas (ex. Estrada_florestal_Exemplo.shp, feição do tipo linha).

•	 Pátios (ex. Patio_Exemplo.shp, feição do tipo ponto).

•	 Trilhas de arraste (ex. Trilha_arraste_Exemplo.shp, feição do tipo linha).

•	 Clareiras produzidas pelo corte e arraste (ex. Arvore_Cortadas_Exemplo.shp, feição do   
tipo ponto).

184.	 Iniciar a edição.

185.	 Vetorizar a estrada principal e suas ramificações secundárias.

186.	 Vetorizar os pátios de estocagem (ponto no centro do pátio).

187.	 Vetorizar as trilhas de arraste.

188.	 Vetorizar as árvores (ponto central das clareiras formadas).

189.	 Salvar e fechar a edição (Figura 57).

5.2.2. Definição das zonas tampão limites para alterações produzidas pelas operações 		
florestais

As áreas impactadas serão definidas por meio de zonas tampão (buffers) de acordo com a 
origem do impacto seguindo o padrão sugerido por d’Oliveira et al. (2012):

•	 Trilhas de arraste – buffer de 4 metros definido no eixo central da trilha produz uma 
zona tampão com 8 m de largura.

•	 Estrada florestal – buffer de 6 metros definido no eixo central da estrada produz uma 
zona tampão com 12 m de largura.

•	 Pátio de estocagem – buffer de 20 metros definido no ponto central do pátio de 
estocagem produz uma zona tampão de aproximadamente 1.200 m2.

•	 Clareiras de árvores abatidas – 25 metros definidos no ponto central da clareira 
pressupõem altura total da árvore de 50 m e produzem uma zona tampão de 1.875 m2.
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O dimensionamento das zonas tampão sugerido neste trabalho é bastante conservador e 
baseado em anos de experiência no manejo de florestas na Amazônia. No entanto, não 
precisa necessariamente ser seguido e deve ser adaptado de acordo às necessidades de cada 
estudo. A determinação da zona tampão será feita para cada um dos arquivos de áreas 
alteradas pela exploração criados na seção anterior, por meio da ferramenta Buffer do 
Arctoolbox.

190.	 Clicar em Arctoolbox > Analysis Tools > Proximity > Buffer.

191.	 No campo Input Features, selecionar o arquivo de estradas (ex. C:\Livro_Lidar\SHAPE\	
	 Estrada_Florestal_Exemplo.shp).

192.	 No campo Output Feature Class nomear o arquivo que representará a zona tampão do 	
	 impacto produzido pela construção das estradas (ex. C:\Livro_Lidar\SHAPE\Estrada_	
	 Florestal_buffer_6m_Exemplo.shp).

193.	 No campo Distance (Value or field) habilitar a opção Linear unit e preencher com a 		
	 largura de 6 m.

194.	 Manter as opções FULL no campo Side Type, ROUND no campo End Type e ALL no 		
	 campo Dissolve Type e pressionar Ok.

195.	 Repetir o mesmo procedimento para os arquivos que representam os pátios, trilhas de 	
	 arraste e clareiras (Figura 58), observando os diferentes tamanhos das zonas tampão 	
	 adotados para cada caso. 

196.	 Unir as quatro zonas tampão (buffers) criadas por meio da ferramenta Union.

197.	 Clicar em Arctoolbox > Analysis Tools > Overlay > Union.

198.	 No campo Input Features, selecionar os arquivos que representam as zonas tampão 	
	 criados (ex. Estrada_florestal_buffer_6m_Exemplo, trilha_arraste_buffer_4m_Exemplo, 	
	 Patio_buffer_20m_Exemplo e Arvore_buffer 25m_Exemplo.shp).

199.	 No campo Output Feature Class nomear o arquivo que irá representar o somatório de 	
	 todas as zonas tampão das áreas alteradas (ex. C:Livro_Lidar\SHAPE\Area_Impacto_	
	 Buffer_Unidos.shp).

200.	No campo Join Attributes (optional) manter a opção ALL e pressionar Ok.

201.	 Com toda área de impacto unificada, por meio da ferramenta Clip, fazer o recorte do 	
	 arquivo que representa o somatório das zonas tampão das áreas impactadas (ex. C:\	
	 Livro_Lidar\SHAPE\Area_Impacto_Buffer_Clip_Exemplo.shp), usando o polígono que 	
	 representa a área de estudo (ex. o limite da amostra de 100 hectares, representada 		
	 pelo arquivo Poligono_Exemplo.shp). Esse procedimento evita que no cálculo das 		
	 áreas de impacto sejam incluídas partes da zona tampão projetadas fora da área de 	
	 estudo. 

202.	Clicar em Arctoolbox > Analysis Tools > Extract > Clip.

203.	No campo Input Features, selecionar o arquivo que representa as zonas tampão de 		
	 áreas alteradas (ex. Area_Impacto_Buffer_Unidos.shp).

204.	No campo Clip Feature selecionar o arquivo que representa o polígono da área 		
	 estudada (ex. Poligono_Exemplo.shp).

205.	No campo Output Feature Class (optional) salvar o arquivo e endereço como C:\Livro_	
	 Lidar\SHAPE\Area_Impacto_Buffer_Clip_Exemplo e pressionar Ok (Figura 59).
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Figura 57. Vetorização das estradas, pátios, trilhas de arraste e clareiras sobre o modelo de 
densidade relativa de vegetação.
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Figura 58. Localização dos pátios de estocagem (amarelo), estradas florestais (vermelho), 
trilhas de arraste (tracejado) e clareiras (árvores).
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Figura 59. Áreas tampão definidas como limites para o impacto produzido pelas operações 
florestais.
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5.3. Estimativa das áreas alteradas por operações florestais

Dentro das zonas tampão definidas na seção anterior, ainda existem áreas com densidade de 
vegetação relativa diferente de zero. Para aumentar a precisão da estimativa das áreas 
alteradas, será feita a identificação e separação das áreas que realmente tiveram a vegetação 
removida (pixels pretos) nas faixas de altura consideradas (ex. 1 m e 5 m). 

A separação das áreas sem vegetação será feita por meio da ferramenta “Intersect”, que 
produzirá um polígono da interseção entre a zona tampão de impacto definida no item 5.2 
(ex. C:\Livro_Lidar\SHAPE\Area_Impacto_Final_Exemplo.shp) e áreas com vegetação relativa 
igual a zero identificadas no modelo RDM gerado na seção 5.2 (ex. C:Livro_Lidar\ASC\Mod_
Veg_Reltv.asc). Para usar ferramentas de análise em um raster (ASC) é necessário convertê-lo 
na extensão .IMG.

206.	Selecionar a ferramenta do Arctoolbox > Convertion tools > To Raster > ASCII to Raster.

207.	 Na janela ASCII to Raster, selecionar no campo Input Feature, o arquivo ASCII a ser 		
	 convertido (ex. C:\Livro_Lidar\ASC\Modelo_Vegetacao_Relativa.asc). É preciso habilitar 	
	 a opção File (*.ASC) para conseguir visualizar e selecionar arquivos ASC.

208.	Definir o nome e endereço do arquivo de saída no campo Output raster (C:\Livro_Lidar\	
	 RASTER\Model_Veg_Rel.img). É preciso escrever a extensão .img no final do nome do 	
	 arquivo de saída.

209.	Selecionar a opção INTEGER no campo Output data type (optional) e clicar Ok  
	 (Figura 60).

Para converter o raster Model_Veg_Rel.img para polígono (shape):

A imagem Model_Veg_Rel.img possui uma tabela de atributos com valores de 0 a 100. Esses 
valores fazem referência à densidade de vegetação relativa, representada na imagem pela 
escala de cinza, sendo 0 igual ao preto e 100 ao branco. Dessa forma, podem-se identificar as 
áreas impactadas pela operação florestal (pátios, estradas, trilhas e clareiras).

210.	 Abrir a tabela de atributos da imagem Model_Veg_Rel.img.

211.	 Colocar a tabela em ordem crescente (do menor para o maior) na coluna VALUE.

Com a tabela de atributos da imagem Model_Veg_Rel.img aberta ao lado do mapa da área 
faça várias simulações de seleção até encontrar um resultado que seja equivalente ao impacto 
produzido pela exploração florestal. Neste documento será usado, como exemplo, o intervalo 
de valores de 0 a 40 na coluna VALUE (Figura 61). A escolha desse intervalo foi feita com base 
na interpretação visual da cobertura impactada e comparação com diferentes intervalos 
testados na faixa de 0% a 100%.

212.	 Selecionar as linhas da tabela de atributos que contemplem os valores VALUE de 0 	
	 até 40.

213.	 Selecionar a ferramenta do Arctoolbox > Convertion tools > Raster to Polygon.

214.	 No campo Input Raster selecionar o raster a ser convertido (ex. Model_Veg_Rel.img). 	
	 Manter o campo Field como VALUE, nomear o arquivo de saída (ex. C:\Livro_Lidar\	
	 SHAPE\Modelo_Vegetacao_Relativa_Exemplo.shp), desabilitar a opção Simplify 		
	 plygons e clicar Ok (Figura 62).

Após a conversão do Model_Veg_Rel.img em polígono é possível fazer a interseção com a 
área de impacto total gerada a partir das estradas, pátios, trilhas de arraste e clareiras. 
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215.	 Clicar em Arctoolbox > Analysis Tools > Overlay > Intersect (Figura 63).

216.	 No campo Input Features, selecionar os arquivos correspondentes às zonas tampão 	
		 (ex. Area_Impacto_Buffer_Unidos.shp) e RDM (ex. Modelo_Vegetacao_Relativa_		
		 Exemplo.shp), nesta ordem, pois o produto final de interesse é a intersecção desses 	
		 dois polígonos (Figura 64).

217.		 No campo Output Feature Class inserir o endereço e nome do arquivo a ser 			
		 produzido (ex. C:\Livro_Lidar\SHAPE\Area_Impacto_Final_Exemplo.shp).

218.	 No campo Join Attributes (optional) manter a opção ALL e pressionar Ok.

219.	 Selecionar a ferramenta XtoolsPro > Table Operations >Calculate Area. 		
		

220.	 Na janela Select layer to measure, inserir o shape produzido no item anterior (ex. 		
		 Area_Impacto_Final_Exemplo.shp).

221.	 Selecionar a unidade de medida Meters na aba Desired output units.

222.	 Pressionar Ok e abrir a tabela de atributos do shape para ver área calculada.

A área calculada referente ao impacto das atividades de exploração florestal dentro da 
amostra de 100 hectares foi de 9,6 hectares, ou seja, aproximadamente 10% da área total, 
para valores de densidade relativa da vegetação entre 0 e 40.



98

Uso do Lidar como Ferramenta para o Manejo de Precisão em Florestas Tropicais

Figura 60. Conversão de arquivos do formato ASCII (Modelo_Vegetação_Relativa_Exemplo.
asc) para o formato raster (img) por meio do comando ASCII to Raster do ArcGis. 

 

Figura 61. Seleção dos valores de densidade de vegetação relativa na faixa de 0% a 40%.
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Figura 62. Ferramenta de conversão da imagem raster em shapefile de polígono.  
 

Figura 63. Aplicação da ferramenta de intercessão de feições (Intersect) do ArcGis (polígonos 
Area_Impacto_Buffer_Unidos.shp e Modelo_Vegetacao_Relativa_Exemplo.shp) para definição 
da área de impacto final produzida pela construção de estradas, abertura de pátios, trilhas de 
arraste e corte das árvores.
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Figura 64. Área de impacto final para valores de densidade relativa da vegetação entre 0% e 
40% com área de 9,6 hectares (aproximadamente 10% da área total da amostra). 
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5.4. Combinando o modelo RDM com o de subtração de cobertura vegetal 

Quando existem disponíveis amostras de dados Lidar da mesma área tomadas antes e após 
a exploração é possível, usando o modelo desenvolvido na seção 4.4, confirmar a localização 
dos pátios de estocagem, estradas florestais, trilhas de arraste e clareiras de árvores em 
função das áreas de copas subtraídas no período entre as duas amostras. Para tanto basta 
sobrepor o modelo de densidade relativa de vegetação (Figura 56) e a vetorização deste 
modelo (Figura 58) com o modelo de diferença de cobertura vegetal desenvolvido no item 
4.4.

Em ambos os casos é possível observar que os polígonos que representam as copas das 
árvores removidas ou danificadas pela exploração estão próximos às áreas alteradas 
identificadas pelo modelo de densidade relativa de vegetação. No exemplo, como a exploração 
já havia iniciado antes do primeiro voo do Lidar, algumas áreas que representam alterações 
promovidas por operações de exploração florestal na parte sul da imagem não possuem a 
representação de árvores removidas ou danificadas (Figura 65).
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Figura 65. Sobreposição do modelo de diferença de cobertura vegetal em diferentes amostras 
Lidar (verde) com o modelo de densidade relativa de vegetação (RDM) e vetorização das 
estradas, pátios, trilhas de arraste e clareiras.
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6. Estimativas de biomassa e estoques de carbono pelo cruzamento de dados Lidar em 
inventários florestais executados na superfície

Estoques de carbono e biomassa podem ser estimados por meio do estabelecimento de uma 
regressão entre os dados Lidar e informações obtidas em campo em inventários florestais 
regulares. No preparo dos dados do Lidar para análise são necessários três passos em que 
serão usados três comandos do Fusion: a) recortar os dados do Lidar contidos nas parcelas 
amostradas em campo (Polyclipdata); b) normalizar as alturas das árvores nos arquivos 
recortados (Subtractground); e c) gerar as estatísticas com os dados métricos dos retornos do 
Lidar contidos nas amostras (Cloudmetrics).

6.1. Seleção dos dados Lidar nas amostras das parcelas

O comando Polyclipdata faz o recorte dos dados do Lidar localizados dentro das parcelas 
distribuídas na área sobrevoada pelo Lidar. Para isso, as parcelas precisam ter seus vértices 
georreferenciados com precisão centimétrica em campo. Um polígono deve ser produzido a 
partir das coordenadas dos vértices de cada parcela no mesmo sistema de referência e 
projeção dos dados Lidar. O arquivo shape gerado (ex. C:\Livro_Lidar\SHAPE\Parcelas_
Permanentes.shp) será utilizado para executar o recorte das parcelas por meio do comando 
Polyclipdata (linha de comando 6). A linha de comando deve ser editada e executada no MS-
DOS de acordo com o descrito nos itens 2.1 e 2.2. Após o recorte dos dados Lidar dentro de 
cada parcela (PP_Exemplo_1.lda. PP_ Exemplo_2.lda. PP_ Exemplo_3.lda. PP_ Exemplo_4.lda. 
PP_ Exemplo_5.lda e PP_ Exemplo_6.lda), seguir os comandos do item 2.3 deste trabalho 
para criar a imagem das parcelas no Fusion e visualização tridimensional no LDV. Após o fim 
do processamento, verificar no Fusion se as parcelas foram recortadas corretamente (Figura 
66).
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Figura 66. Amostras de dados Lidar recortados conforme polígono de parcelas permanentes.
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6.2. Normalização dos dados Lidar das parcelas

A normalização da elevação é uma etapa necessária para gerar estatísticas das elevações dos 
retornos contidos nas parcelas. A normalização das alturas é feita a partir do modelo de 
superfície (C:\Livro_Lidar\DTM\Modelo_Superficie_Exemplo.dtm). Com os valores de elevação 
dos retornos normalizados é possível fazer os cálculos das estatísticas desses retornos 
(médias, variância, desvio padrão e etc.) nas parcelas. 

Para a normalização das alturas nas áreas selecionadas serão usadas duas linhas de comando 
com Subtractground (linha de comando 7) e Clipdata (linha de comando 8). Esses dois 
comandos permitem a execução dessa operação em mais de uma amostra (no caso do 
exemplo, parcelas) de uma única vez. A edição e execução das linhas de comando serão 
feitas conforme os itens 2.1, 2.2 e 2.3 deste trabalho. Um arquivo de texto deve ser criado 
com o endereço e nome dos arquivos das parcelas (item 2.3.1).

223.	Digitar C:\Livro_Lidar\BAT\Subtrair_Elevacao_Parcela_Exemplo no MS-DOS dentro da 
pasta C:\Fusion e 			   pressionar Ok.

Após completar o processamento, verificar na pasta C:\Livro_Lidar\LAS_LDA se os arquivos 
(PP_Exemplo_n_Normalizada.lda) foram criados. No LDV é possível visualizar se os pontos 
das parcelas foram corretamente normalizados (Figura 67).
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                                               A

                                              B

 
 
Figura 67. Comparação das imagens tridimensionais das parcelas permanentes sob condições 
reais do terreno (A) e com elevação normalizada (B).
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6.3. Geração das estatísticas das alturas dos retornos do Lidar por meio do comando 
Cloudmetrics

Os arquivos com elevação normalizada criados na etapa anterior (PP_1_Normalizada.lda. 
PP_2_ Normalizada.lda. PP_3_ Normalizada.lda. PP_4_ Normalizada.lda. PP_5_ Normalizada.
lda. PP_6_ Normalizada.lda) serão usados para gerar estatísticas da intensidade e altura de 
todos os retornos contidos nas parcelas. As estatísticas serão calculadas por meio do comando 
Cloudmetrics do Fusion. A edição e execução da linha de comando (linha de comando 9) 
serão feitas conforme os itens 2.2 e 2.3 deste trabalho. O carregamento de arquivos CSV no 
Excel, quando o MS Office estiver configurado para o idioma Português, deve ser precedido 
de uma alteração nas opções do programa para trocar a separação de decimais de vírgulas 
para pontos.

224.	No menu principal do Excel selecionar: Arquivo > Opções > Avançado e desabilitar a 	
	 caixa Usar separadores de sistema (Figura 68).

Após a configuração do Excel para a abertura do arquivo CSV:

225.	No menu principal do Excel selecionar Dados > De texto, navegar no browser até a 		
	 pasta 	C:\Livro_Lidar\CSV, selecionar o arquivo Metricas_PP_Exemplo.csv e pressionar 	
	 Importar. 

226.	Na etapa 1 manter o campo “Delimitado” selecionado e pressionar Avançar (Figura 	
	 69); na etapa 2, no campo delimitadores, manter apenas a opção Vírgula habilitada 		
	 (Figura 70); e na etapa 3, manter os dados da coluna com a opção Geral e pressionar 	
	 Concluir (Figura 71). 

227.	 O Excel indicará =$A$1 como célula inicial para o carregamento dos dados, 			 
	 pressionar Ok e os dados do arquivo serão carregados. Verificar nas colunas 			 
	 se os decimais estão corretamente separados por pontos. O arquivo deve conter 		
	 dezenas de variáveis descritas na Tabela 3.
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Figura 68. Janela de opções do Excel para trocar a separação de decimais de vírgulas para 
pontos na caixa Usar separadores de sistema.

 

Figura 69. Importação do arquivo metricas_PP_exemplo.csv como planilha eletrônica no Excel 
– etapa 1.
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Figura 70. Importação do arquivo metricas_PP_exemplo.csv como planilha eletrônica no 
Excel – etapa 2.

 

Figura 71. Importação do arquivo metricas_PP_exemplo.csv como planilha eletrônica no 
Excel – etapa 3.
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Tabela 3. Métricas de elevação e intensidade dos dados Lidar contidos na parcela 1.

Identificação: 1
Arquivo de dados: C:\Livro_Lidar\LAS_LDA\PP_1_Normalizada.Ida
Título do arquivo: PP_1_Normalizada

Retorno
Total de retornos acima de 
1 metro

110920 Nº de primeiro retorno acima de 
2 metros

73013

Nº de primeiro retorno 
acima de 1 metro

74375 Total de retornos acima de 2 
metros

106237

Nº de segundo retorno 
acima de 1 metro

30348 Primeiro retorno acima da média 
(%)

52,149333

Nº de terceiro retorno 
acima de 1 metro

5695 Primeiro retorno acima da moda 
(%)

67,981507

Nº de quarto retorno acima 
de 1 metro

502 Total de retornos acima da 
média (%)

40,183511

Nº de quinto retorno acima 
de 1 metro

0 Total de retornos acima da moda 
(%)

53,688402

Nº de sexto retorno acima 
de 1 metro

0 (Total de retornos acima da 
média) / (Total de primeiros 
retornos) * 100

64,067893

Nº de sétimo retorno 
acima de 1 metro

0 (Total de retornos acima da 
moda) / (Total de primeiros 
retornos) * 100

85,599856

Nº de oitavo retorno acima 
de 1 metro

0 Primeiro retorno acima da média 40495

Nº de nono retorno acima 
de 1 metro

0 Primeiro retorno acima da moda 52789

Outros retornos acima de 
1 metro

0 Total de retornos acima da 
média

49750

Primeiro retorno acima de 
2 metros (%)

94,02591 Total de retornos acima da moda 66470

Total de retornos acima de 
2 metros (%)

85,808557 Total de primeiros retornos 77652

(Total de retornos acima 
de 2 m) / (Total de 
primeiros retornos) * 100

136,811673 Total de retornos 123807

Elevação Intensidade

Elevação mínima 1,000019 Intensidade mínima 2
Elevação máxima 43,214153 Intensidade máxima 1740
Elevação média 19,73733 Intensidade média 313,489497
Moda da elevação 16,411528 Moda da intensidade 29,587302
Desvio padrão da elevação 10,99309 Desvio padrão da intensidade 212,305864
Variância da elevação 120,848026 Variação da intensidade 45073,77996
Covariância da elevação 0,556969 Covariância da intensidade 0,677234
Interquartil da distância da 
elevação

14,516041 Interquartil da distância da 
intensidade

395

Skewness da elevação 0,373532 Intensidade de Skewness 0,151617
Kurtosis da elevação 2,35037 Intensidade de Kurtosis 1,822634

Continua...
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Identificação: 1
Arquivo de dados: C:\Livro_Lidar\LAS_LDA\PP_1_Normalizada.Ida
Título do arquivo: PP_1_Normalizada
Média absoluta do desvio 
da média de elevação 
(AAD)

8,824351 Média absoluta do desvio da 
média da intensidade (AAD)

186,955518

Elevação média no 
primeiro quartil (L1)

19,73733 Intensidade média no primeiro 
quartil (L1)

313,489497

Elevação média no 
segundo quartil (L2)

6,232063 Intensidade média no primeiro 
quartil (L2)

121,859908

Elevação média no terceiro 
quartil (L3)

0,551018 Intensidade média no primeiro 
quartil (L3)

5,288408

Elevação média no quarto 
quartil (L4)

0,572359 Intensidade média no primeiro 
quartil (L4)

-2,577694

Covariância L-moments da 
elevação

0,31575 Covariância L-moments da 
intensidade

0,388721

L-moments de Skewness 
para a elevação

0,088417 L-moments de Skewness para a 
intensidade

0,043397

L-moments de Kurtosis 
para a elevação

0,091841 L-moments de Kurtosis para a 
intensidade

-0,021153

Altura média do primeiro 
percentil

1,18617 Intensidade média do primeiro 
percentil

9

Altura média do quinto 
percentil

2,415284 Intensidade média do quinto 
percentil

22

Altura média do primeiro 
decil

5,75385 Intensidade média do primeiro 
decil

36

Altura média do segundo 
decil

9,820114 Intensidade média do segundo 
decil

76

Altura média do primeiro 
quartil

11,591261 Intensidade média do primeiro 
quartil

105

Altura média do terceiro 
decil

13,480918 Intensidade média do terceiro 
decil

142

Altura média do quarto 
decil

16,396067 Intensidade média do quarto 
decil

220

Altura média do segundo 
quartil

18,566099 Intensidade média do segundo 
quartil

320

Altura média do sexto 
decil

20,859247 Intensidade média do sexto decil 400

Altura média do sétimo 
decil

23,905083 Intensidade média do sétimo 
decil

460

Altura média do terceiro 
decil

26,107302 Intensidade média do terceiro 
decil

500

Altura média do oitavo 
decil

29,826891 Intensidade média do oitavo 
decil

520

Altura média do nono decil 37,781044 Intensidade média do nono decil 600
Altura média do 
nonagésimo quinto decil

40,082848 Intensidade média do 
nonagésimo quinto decil

640

Altura média do quarto 
quartil

42,209417 Intensidade média do quarto 
quartil

740

Tabela 3. Continuação.

Continua...
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As estatísticas serão usadas para construir modelos de regressão com parâmetros estruturais 
da floresta (área basal, volume, biomassa e carbono) obtidos a partir dos dados das parcelas. 
Com os dados da área da amostra utilizada neste livro foram desenvolvidas as seguintes 
equações (d’Oliveira et al., 2012): 

BSA = (3.119 + 0.564 P25 + 0.062 Var)2 + 1.74 (R2
adj = 0.72; Erro padrão = 40.2).

V = (4.062 + 0.496 P25 + 0.046 Var) 2 + 1.21 (R2
adj = 0.69; Erro padrão = 30.5).

AB = 3.503 + 1.447 P25 + 0.101 Var (R2
adj = 0.63; Erro padrão = 3.3).

Onde:

BSA = biomassa seca acima do solo (Mg .ha-1. árvores DAP ≥ 10 cm).

V = volume (m3.ha-1. árvores DAP ≥ 10 cm).

AB = área basal (m2.ha-1. árvores DAP ≥ 10 cm).

P25 = equivale aos retornos do primeiro quartil ou 25% percentil. 
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7. Extrapolação de modelos de regressão produzidos para dados Lidar destinados a toda área 
amostrada

A extrapolação dos modelos de regressão gerados na seção anterior, com base na área das 
parcelas do inventário florestal, para toda a área amostrada pelo Lidar, é possível por meio 
do comando Gridmetrics. Esse comando produz estatísticas semelhantes às produzidas pelo 
Cloudmetrics para toda área amostrada pelo Lidar. Os arquivos com estatísticas para elevação 
e intensidade dos retornos são produzidos no formato CSV. Diferente do Cloudmetrics, onde 
cada linha do arquivo gerado representava as estatísticas de uma parcela, no Gridmetrics as 
estatísticas serão geradas para células com tamanho definido pelo usuário (ex. 50 m x 50 m) 
e cada coluna corresponde a uma variável. 

Como a extrapolação dos modelos será feita no ArcGis, os arquivos CSV serão convertidos 
ao formato ASCII pelo comando CSV2grid e, finalmente, convertidos ao formato raster (TIF). 
Dessa forma, estimativas de biomassa e estoques de carbono poderão ser feitas para qualquer 
parte da área coberta pelo Lidar.

7.1. Geração de estatísticas para dados Lidar de uma amostra – Gridmetrics 

Os arquivos de dados da amostra Lidar (.LAS) serão usados para gerar estatísticas da 
intensidade e elevação de todos os retornos contidos na amostra. As estatísticas serão 
calculadas por meio do comando Gridmetrics do Fusion. A edição e execução da linha de 
comando Metricas_Lidar_Grade_Amostra_Exemplo (linha de comando 10) serão feitas 
conforme os itens 2.3 e 2.4 deste trabalho. 

O marco inicial para a construção do modelo Gridmetrics é o ponto central da primeira célula 
no canto esquerdo inferior da amostra. Para determinar a localização (coordenadas X,Y) 
desse ponto é preciso ter a coordenada do vértice da amostra e o tamanho das células do 
modelo que será produzido.

Considerando células com tamanho de 50 m x 50 m e as coordenadas do vértice do canto 
esquerdo inferior da amostra (C:\Livro_Lidar\SHAPE\Vertices_amostra) X = 579074.196841 e Y 
= 8970250.00073 (Figura 72), o valor da coordenada X do ponto central é 579074.196841 + 25 
= 579099 e o valor da coordenada Y do ponto central é 8970250.00073 + 25 = 8970275.

Do comprimento e largura da amostra (1.000 m x 1.000 m) deve ser subtraída a dimensão da 
célula do exemplo (50 m x 50 m), resultando no parâmetro 950,950 usado no BatFile 
Gridmetrics. Esse parâmetro evita que a linha de comando projete células fora da amostra.

O arquivo produzido pelo Gridmetrics é uma planilha de dados no formato CSV (coma 
separated value) compatível com outras planilhas como o Excel (Figura 65). Após a conversão 
ao formato raster (TIF), as estatísticas serão usadas para a extrapolação dos modelos de 
regressão produzidos com parâmetros estruturais da floresta (área basal, volume, biomassa 
e carbono) obtidos a partir dos dados das parcelas.
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Figura 72. Tabela de atributos do shapefile dos vertices_amostra de dados Lidar (Vertices_
amostra.shp) com destaque para as coordenadas do vértice 01 referente à parte inferior 
esquerda da amostra. 
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7.2. Conversão de arquivos CSV para o formato ASCII – CSV2Grid e raster (TIF)

A conversão do arquivo contendo as estatísticas de elevação e intensidade dos retornos de 
toda a área ao formato ASCII será feita por meio do comando CSV2Grid do Fusion. Um arquivo 
ASC será gerado para cada variável independente presente no modelo de regressão (ex. 
variância – ElevVar e altura média no primeiro quartil – P25). A edição e execução das linhas 
de comando 11 e 12 (Converte_CSV_ASC_ElevP25 e Converte_CSV_ASC_ElevVar) serão feitas 
conforme os itens 2.3 e 2.4 deste trabalho. A conversão ao formato raster (TIF) deve ser feita 
seguindo os procedimentos dos itens 2.5.3 e 2.5.4 deste trabalho.
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7.3. Estimativas de parâmetros estruturais da floresta (biomassa, volume, área basal) a partir 
de amostras Lidar

Com os arquivos produzidos pelo Gridmetrics exportados para o ArcGis (formato ASC) é 
possível calcular a biomassa de cada célula (no exemplo 50 m x 50 m) da imagem produzida 
por meio da aplicação do modelo de regressão obtido seguindo os procedimentos da seção 
6. Neste livro será utilizado como base o modelo desenvolvido por d’Oliveira et al. (2012) para 
produzir a estimativa de biomassa seca acima do solo na amostra usada como exemplo. 

228.	 Selecionar a ferramenta Spatial Analyst > Raster Calculator.

229.	 Na janela aberta digitar a equação BSAS = (3.119 + 0.564 * P25 + 0.062 * VAR)2 + 1.74 	
	 (ex. biomassa seca acima do solo).

230.	 Substituir P25 e VAR pelas imagens Gridmetrics_exemplo_P25.asc e Gridmetrics_		
	 returns_elevvariance.asc, respectivamente.

231.	 Teclar evaluate (Figura 73).

A equação final fica da seguinte forma: 

BSAS = (3,119 + 0,564 * [Gridmetrics_returns_ElevP25.asc] + 0,062 * [Gridmetrics_returns_
elevvariance.asc]) * (3,119 + 0,564 * [Gridmetrics_ returns_elevP25.asc] + 0,062 * [Gridmetrics_
returns_elevvariance.asc]) + 1,74

Onde:

[Gridmetrics_returns_elevP25.asc] = altura média no primeiro quartil dos pontos presentes 
em cada célula da amostra.

[Gridmetrics_returns_elevvariance.asc] = variância da altura dos pontos presentes em cada 
célula da amostra.

232.	Selecionar a ferramenta Spatial Analyst > Zonal Statistics.

233.	 Na janela aberta selecionar no campo Zone dataset o nome do arquivo que delimita a 	
	 área que será estudada (no exemplo C:\Livro_Lidar\SHAPE\Polígono_Exemplo.shp).

234.	No campo Zone field selecionar o campo que contém as informações sobre o polígono 	
	 (no exemplo Nome).

235.	No campo Value raster selecionar o arquivo com os valores da biomassa seca acima 	
	 do solo para todas as células da área (no exemplo BSAS_Lidar).

236.	No campo Chart statistic selecionar Mean.

237.	 No campo Output table selecionar o diretório e nome do arquivo de saída C:\Livro_		
	 Lidar\|XLS\Estatistica Biomassa.dbf.

238.	Clicar Ok (Figuras 74 e 75).
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Figura 73. Imagem representando a biomassa seca acima do solo (Mg .ha-1), calculada para 
as árvores acima de 10 cm de DAP, em células de 50 m x 50 m da amostra de 100 hectares de 
dados Lidar.
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Figura 74. Média da biomassa seca acima do solo nas quatro subáreas em que a amostra de 
100 hectares está dividida. 

Figura 75. Estatísticas para a biomassa nas quatro subáreas da amostra. 
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